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1 Introduction
Le logiciel Aladin est un atlas interactif du ciel. Il permet aux utilisateurs de visualiser 
des images digitalisées du ciel et d'y superposer des informations issues de catalogues ou 
de bases de données astronomiques. Il permet ainsi d'accéder de façon interactive à la 
plupart des données images et catalogues accessibles par l’Internet et notamment aux 
données de SIMBAD, NED, VizieR, MAST/STScI, CADC, HEASARC,  SLOAN, NVSS…
 
Aladin est un logiciel dédié aux professionnels de l’astronomie. Il peut être également 
utilisé  par  des  enseignants,  des  étudiants,  des  amateurs.  Il  est  gratuit  sous  licence 
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UdS/CNRS (voir mention légale). Il a été traduit en plusieurs langues dont l’anglais, le 
français, l’italien, l'allemand, l'iranien, le russe, le chinois…

Aladin est couramment utilisé pour :
 La visualisation et la vérification des données images et catalogues 
 L’exploration des données astronomiques disponibles
 La préparation de missions d’observations
 La génération de cartes de champs

Le logiciel Aladin peut être également « inséré » dans une page Web afin de permettre la 
visualisation dynamique de données dans un simple navigateur tels Internet Explorer ou 
Firefox. De nombreux instituts et projets astronomiques utilisent cette technique pour 
offrir  à  leurs  propres utilisateurs  la  consultation  interactive  de leurs  données  (NED, 
CADC, MAST, ESAC, ESO…).

Aladin est développé par le Centre de Données astronomiques de Strasbourg (CDS). Il 
est  compatible  avec  la  plupart  des  configurations  informatiques  et  notamment 
Windows, Linux et Mac. Il ne nécessite pas de ressources informatiques importantes à 
moins qu’il n’ait à manipuler de très grands catalogues (plusieurs centaines de milliers 
d’objets)

Créé en 1999, Aladin supporte les standards émergents de l'Observatoire Virtuel, il est 
interconnectable  avec  d'autres  outils  de  visualisation  et  d'analyse  (IDL,  VOPlot, 
TOPCAT, Specview, SPLAT, VOSpec,…). Tous ces points forts lui permettent d'être un 
puissant outil d'exploration et d'intégration de données : un outil scientifique en tant 
que tel.

L’adresse du site Web d’Aladin est la suivante : http://aladin.u-strasbg.fr. 

2 Installation

La méthode d’installation d’Aladin dépend de votre configuration matérielle. Dans tous 
les cas, cela ne vous prendra que quelques secondes.

Installation locale

Aladin ne requiert que quelques mégaoctets d’espace disque pour son installation et 256 
mégaoctets de mémoire vive suffisent pour la plupart des travaux.

Sous Windows
URL : http://aladin.u-strasbg.fr/java/Aladin.exe
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Si  vous travaillez  sous  Windows,  la  méthode la  plus rapide  et  la  plus simple  est  de 
simplement recopier le  fichier  « Aladin.exe » dans un de vos dossiers,  ou même sur 
votre bureau. C’est tout !

Sous Mac  
URL : http://aladin.u-strasbg.fr/java/Aladin.dmg

L’installation  sous  Macintosh  se  présente  sous  la  forme  d’un  classique  paquetage 
« dmg ».  Vous le téléchargez, vous l’ouvrez, et vous copiez le fichier « Aladin.app » 
dans votre dossier « Application ». C’est tout !

Sous Linux   et autres systèmes Unix  
URL : http://aladin.u-strasbg.fr/java/Aladin.tar

L'installation sous Linux se présente comme un fichier archive « tar ». Vous téléchargez 
le fichier, vous décompactez les fichiers via la commande « tar xvf Aladin.tar » ou tout 
autre utilitaire équivalent.  C'est tout !

A noter : Aladin peut être utilisé sur des données stockées localement. Cependant il est 
préférable de disposer d’une connexion Internet,  même de faible débit (≥ 512Kbit/s) 
pour  pouvoir  accéder  également aux  bases  de  données  astronomiques.  Pour  plus  de 
détails sur l’installation d’Aladin ou pour accéder à la dernière version en test, veuillez 
vous référer à la page Web suivante :

http://aladin.u-strasbg.fr/java/nph-aladin.pl?frame=downloading

Aladin en applet

Aladin peut également être utilisé  sans aucune installation préalable,  simplement en 
utilisant  votre  navigateur  Web.  En  cliquant  sur  une  des  URL  ci-dessous,  votre 
navigateur chargera automatiquement le code exécutable d’Aladin puis l’exécutera dans 
sa propre fenêtre.  Aladin a été expressément conçu pour être très compact (environ 2 
mégaoctets afin que le déchargement+démarrage soit le plus bref possible).

 France – Strasbourg (CDS) : http://aladin.u-strasbg.fr/java/nph-aladin.pl
 Canada – Victoria (CADC) : http://vizier.hia.nrc.ca/viz-bin/nph-aladin.pl
 Royaume-Uni – Cambridge: http://archive.ast.cam.ac.uk/viz-bin/nph-aladin.pl
 Japon – Tokyo (ADAC) : http://vizier.nao.ac.jp/viz-bin/nph-aladin.pl
 Inde – Pune (IUCAA) : http://urania.iucaa.ernet.in/viz-bin/nph-aladin.pl
 USA – Harvard (CFA) : http://vizier.cfa.harvard.edu/viz-bin/nph-aladin.pl

Vous devez ensuite accepter l’exécution de l’applet (certification). En cas de refus, Aladin 
démarrera  tout  de  même  mais  en  mode  bridé  qui  réduira  considérablement  ses 
possibilités, voire ses performances.
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3 Prise en main
Pour vous donner un bref aperçu des potentialités d’Aladin, voici un scénario typique de 
visualisation de données images et catalogues autour d’un objet astronomique :

1. Lancement d’Aladin
2. Recherche d’une image optique de l’objet M51
3. Recherche des données SIMBAD autour de cet objet
4. Chargement du catalogue NOMAD autour de cet objet
5. Visualisation des données (déplacement, zoom…)
6. Consultation des mesures et des données originales
7. Sauvegarde

Nous allons suivre pas à pas ce scénario.

Lancement d’Aladin (1)

Le lancement d’Aladin dépend du type 
de  configuration  matérielle  dont  vous 
disposez. Sous Windows et Macintosh, 
un  double-clic  sur  l’icône  d’Aladin  va 
démarrer  l’application.   Sous  Linux  et 
autres  stations  Unix,  il  vous  sera peut 
être nécessaire de passer la commande :

Aladin

 Chargement des données
(2, 3 et 4)

La méthode la plus simple pour charger 
une  image  dans  Aladin  consiste  à 
utiliser  le  menu  « Fichier => Charger  
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une image astronomique => DSS => DSS from ESO», puis à indiquer le nom ou la position 
de  l’objet  central  dans  le  formulaire  qui  apparaît.  Dans  notre  exemple,  il  s’agit  de 
« M51 ». 

Il  ne reste plus qu’à soumettre la 
requête en appuyant sur le bouton 
« CHERCHER »

Le  formulaire  ouvert  à  l’étape 
précédente  permet  de  voir  d’un 
coup d’œil l’ensemble des serveurs 
images  et  catalogues  qu’Aladin 
peut  interroger.  Sur  la  gauche 
apparaît  la  liste  des  serveurs 
images.  De  fait,  l’utilisation  du 
menu à l’étape précédente n’a fait 
que  présélectionner  le  formulaire 
correspondant,  en  l’occurrence 
« DSS from ESO ».  Sur  la  colonne 
de droite apparaissent les serveurs 

de  tables  à  savoir  les  bases  de  données  (Simbad ,  NED…) ainsi  que  la  plupart  des 
catalogues astronomiques (VizieR).
Ainsi  pour  charger  les  données  de  Simbad,  il  est  nécessaire  de  cliquer  sur  l’onglet 
correspondant,  puis  sans  modifier  de  champ  (la  position  centrale  est  identique  à  la 
requête précédente), cliquer sur le bouton « CHERCHER ». En revanche pour charger un 
catalogue il faut indiquer son nom en toutes lettres dans le formulaire VizieR avant de 
soumettre la requête. Dans le cas du catalogue NOMAD, comme il s’agit d’un très grand 
relevé,  il  est  possible d’y  accéder  de manière plus directe par l’onglet  « Surveys »,  de 
cliquer  sur  la  ligne  correspondante,  puis  de  soumettre  la  requête  via  le  bouton 
« CHERCHER ».

Visualisation des données (4)

La visualisation des données se fait  dans la 
fenêtre principale  d’Aladin.  Elle  se compose 
principalement de 4 éléments :

1. La  pile :  présente  l’ensemble  des 
données  chargées  sous  forme  d’un 
empilement  de  « plans ».  L’œil  de 
l’observateur  se  trouve  en haut  de  la 
pile  et  va  voir  « en  transparence » 
l’ensemble des plans activés.

2. Le  zoom : visualise  la  portion  de 
l’image  visible  (rectangle  bleuté)  en 
fonction  du  centre  et  du  facteur 
courant du zoom.

3. La vue : affiche la portion de l’image 
visible en fonction des plans de la pile 
et du zoom et superpose à cette image 
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des symboles graphiques correspondants aux objets astronomiques des tables et 
catalogues chargés.

4. Les  mesures : affiche  les  paramètres  des  objets  astronomiques  sélectionnés 
dans la vue au moyen de la souris (magnitude, parallaxe…)

Activation d’un plan     :   L’activation ou la désactivation d’un plan se fait en cliquant sur la 
petite coche à gauche du logo de chaque plan de la pile. Il est également possible de 
permuter les plans via la souris (cliquer/glisser/déposer) pour changer l’avant-plan afin 
de faciliter la lecture de la vue (par exemple une image sur le dessus de la pile cache les 
catalogues en dessous). 

Réglage du zoom     :   La manière la plus immédiate d’ajuster le 
coefficient du zoom consiste à utiliser la roulette de la souris 
en ayant le pointeur de la souris positionné « dans le zoom » 
ou  « dans  la  vue ».  Si  vous  ne  disposez  pas  d’une  souris  à 
roulette,  vous pouvez utiliser le sélecteur juste au-dessus du 
cadre du zoom.

Déplacement dans l’image     :   Pour se déplacer dans l’image, il 
faut faire glisser le rectangle bleuté du zoom au moyen de la 
souris (cliquer/glisser).

Centrage sur un objet particulier     :   Le centre de la vue fait apparaître un réticule (petite 
croix de couleur magenta). La méthode la plus simple pour pointer et zoomer sur une 
objet particulier consiste à placer le réticule sur l’objet en question (par un simple clic 
souris), puis à zoomer au moyen de la roulette de la souris. La vue va automatiquement 
se centrer sur l’objet.

Consultation des mesures et des données originales (6)

La vue fait apparaître en superposition de l’image les objets issus des 
catalogues et des tables – dans notre exemple Simbad et NOMAD. 
Chacun de ces objets peut être sélectionné au moyen de la souris, soit 
en  cliquant  dessus,  soit  en  les  englobant  dans  un  rectangle  de 
sélection (cliquer hors de tout objet – déplacer – relâcher).

Les objets sélectionnés apparaissent entourés  d’un petit carré vert. 
Les mesures qui leur sont associées s’inscrivent sous forme d’une table dans le panneau 
des mesures. Certaines valeurs apparaissent soulignées en bleu comme un « lien Web ». 
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En  cliquant  sur  un  des  liens,  Aladin  ouvrira  votre  navigateur  et  affichera  des 
informations  additionnelles.  Le  premier  lien  est  généralement  utilisé  pour  afficher 
l’enregistrement complet original.

La sauvegarde (7)

Aladin propose plusieurs options de sauvegardes afin de conserver la vue courante sous 
forme d’une image ou d’un fichier pour une publication scientifique, etc. Par le menu 
« Fichier  => Enregistrer  la  vue  courante  => PNG » vous  obtiendrez  un  fichier  image 
correspondant  à  la  vue  courante  facilement  utilisable  dans  la  plupart  des  outils 
bureautiques.

Après  cette  découverte  rapide  de  l’outil,  voyons  plus  en  détail  les  possibilités  de 
traitement qu’offre Aladin

4 Aperçu des possibilités de traitement
Aladin travaille principalement sur 3 types de données : des images, des catalogues 
et des  surcharges graphiques qu’il visualise dans une ou plusieurs «  vues ».  Pour 
chacun de ces éléments, Aladin dispose d’une série d’outils.
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Définitions au sens d’Aladin

 Une image astronomique est un tableau rectangulaire de valeurs représentant un 
champ  de  vue  du  ciel.  L’image  astronomique  est  généralement  fournie  avec  des 
informations entre autres relatives à son origine et à sa calibration (position dans le 
ciel, taille du pixel, type de projection,…) ;

 Un catalogue astronomique est une table, ou plusieurs tables, dont chaque ligne 
représente des informations sur un objet ou « source » astronomique (identificateur, 
position dans le ciel, caractéristiques physiques…) ;

 Une surcharge graphique est un ou plusieurs éléments graphiques (trait, cercle, 
polygone…) auxquels sont associées des positions dans le ciel ;

 Une vue est une projection d’une portion d’une image sur laquelle peut être tracés 
des  symboles  associés  à  chaque  source  des  catalogues  et/ou  des  surcharges 
graphiques ;

 La position dans le ciel est classiquement un couple d’angles (RA – ascension droite, 
DEC – déclinaison) permettant  de se positionner sur la sphère céleste.  Aladin ne 
manipule pas la notion de distance à l’observateur, uniquement la représentation sur 
la sphère céleste.
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Nous  allons  brièvement  décrire  les  différentes  opérations  qu’Aladin  offre  pour 
manipuler les images, les catalogues, les surcharges graphiques et les vues. 

Opérations sur les images

 Ajustement de la dynamique des pixels (contraste) ;
 Opération de symétrie (haut / bas, droite / gauche) ;
 Composition d’une image couleur à partir de 3 images ;
 Création d’une mosaïque d’images juxtaposables ;
 Génération d’un cube d’images à partir de plusieurs images du même champ ;
 Rééchantillonnage d’une image en fonction de la solution astrométrique d’une autre 

image ;
 Calibration astrométrique d’une image (par paramètres ou par correspondance sur 

un catalogue ou une autre image) ;
 Calcul  sur les pixels (addition, soustraction,  multiplication, division, convolutions, 

normalisation).

A  noter :  Dans  le  cas  des  « très  grandes  images »  (plusieurs  gigaoctets)  seules  les 
fonctions de bases sont disponibles (dynamique, symétrie)
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Opérations sur les catalogues

 Manipulation des mesures associées aux sources (sélection, filtrage, tri, pointage….) ;
 Paramétrage de la représentation graphique des sources en fonction des valeurs des 

mesures (ex : cercles proportionnels à la magnitude, flèches de mouvement propre, 
ellipses d’erreur….) ;

 Corrélation des sources de deux catalogues ;
 Calcul de nouvelles colonnes de mesures ;
 Calibration astrométrique d’un catalogue n’ayant pas de coordonnées célestes.

Opérations sur les surcharges graphiques

 Extraction de contours (ou « isophotes ») ;
 Outils graphiques :

 Outil de mesures de distance ;
 Outil  de  positionnement  de  marques 

(balises) ;
 Traçages à main levée ;
 Surcharges de texte ;
 Graphes  de  coupe  de  l’image  le  long  de 

segments de droite ou dans la 3ème dimension 
dans le cas d’un cube.

 Superposition d’une grille de coordonnées ;
 Superposition  de  champs  de  vue 

instrumentaux (« Field of View » ou « FoV ») ;
 Déplacement ;
 Rotation.

Opérations sur les vues 

 Superposition des catalogues, surcharges graphiques et éventuellement surcharges 
d’autres images par semi transparence ;

 Zoom et déplacement ;
 Visualisation de plusieurs vues côte à côte (2,4,9 ou 16 vues simultanées) ;
 Synchronisation de vues (même échelle, même orientation) ;
 Génération de vues « vignettes » autour d’objets d’intérêt ;
 Visualisation plein écran.
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Ces  différentes opérations  sont  réalisables  au 
moyen  d’une  interface  graphique  classique. 
Comme habituellement dans ce type de logiciel, 
plusieurs alternatives sont proposées répondant 
aux différentes habitudes de travail :

1. la barre de menu en haut de la fenêtre ;
2. la  barre  des  outils  (liste  de  boutons  à 

cliquer) ;
3. des  menus  contextuels  accessibles  par 

clic droit ou CTRL clic (Mac) ;
4. des  raccourcis  clavier  (combinaison  de 

touches). 

A noter : il est également possible de réaliser ces 
opérations via des commandes en lignes via le 
mode script qui est décrit à la fin de ce manuel 
(cf. 7.1)

Nous allons découvrir les différents éléments qui composent cette interface graphique, 
leurs modes de fonctionnement, etc.

5 L’interface graphique dans le détail
Aladin offre  une interface  graphique  riche et  sophistiquée  permettant  de  réaliser  en 
quelques clics la plupart des fonctions de bases.  Les deux principales fenêtres sont :
 La « fenêtre principale » qui sert à visualiser et manipuler les données ;
 Le « sélecteur  de  serveurs »  qui  permet  la  localisation  et  l’accès  aux  données 

astronomiques sur l’Internet ou localement.

Plusieurs autres fenêtres permettent divers contrôles, dont les principaux sont :
 Le contrôle de la dynamique des pixels (contraste) ;
 L’extraction de contours ;
 L’édition des filtres appliqués sur les catalogues ;
 Le calcul des corrélations entre catalogues ;
 Le calcul et l’ajout de nouvelles colonnes sur les catalogues ;
 Le contrôle de la calibration astrométrique ;
 Le contrôle du rééchantillonnage d’images ;
 Les opérations arithmétiques sur les images
 Les sauvegardes ;
 La gestion des préférences de l’utilisateur (configuration) ;
 La console de commandes pour l’utilisation du mode script.

Nous allons  maintenant passer en revue les différents éléments de l’interface, présenter 
leur rôle, leurs interactions…
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A noter : Suivant le profil de l’utilisateur, il est possible de démarrer Aladin en mode 
scolaire  (« undergraduate »)  ou simple  affichage  (« preview »  )  afin  de  faciliter  l’usage 
pour ce type de public. Selon le mode utilisé, Aladin présentera une interface plus ou 
moins allégée. Ces deux modes seront étudiés ultérieurement.

5.1 La fenêtre principale
Aladin  regroupe  dans  une  unique  fenêtre  la  plupart  des  éléments  nécessaires  à  la 
visualisation  et  à  l’exploitation  des  données :  une  barre  de  menu,  un  bandeau  de 
localisation, le panneau des vues, le zoom, la pile, un panneau pour les mesures.

Astuce : Les proportions relatives des différents éléments peut être modifiées au moyen 
de l’icône en forme de doubles flèches croisées  située en bas de la barre des outils. 
Cliquez/déplacez/relâchez pour ajuster les proportions.
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Visite guidée

Menu : Aide => Visite guidée d’Aladin…
Aide => Montre-moi comment faire…

Pour aider  à  la  découverte  de la fenêtre principale,  Aladin vous suggère  une « visite  
guidée » que vous trouverez dans le menu « Aide ». Une fois la fonction activée, utilisez 
votre  souris  et  survolez  les  différents  éléments  de  la  fenêtre  principale  pour  faire 
apparaître une description du composant pointé.

D’autre part, Aladin propose une série de « démonstrations » accessibles via le menu 
« Aide  => Montre-moi  comment  faire… ».  Lors  d’une  démonstration,  une  fenêtre  de 
dialogue vous explique pas à pas les manipulations à entreprendre et  le  pointeur de 
votre souris va se déplacer tout seul, vous montrant « comment faire ».

5.1.1 La pile

La pile représente l’ensemble des données chargées en mémoire et susceptibles d’être 
affichées  dans  une  vue.  La  pile  est  structurée  comme  un  ensemble  de  « plans » 
superposés  les  uns  au-dessus  des  autres.  L’utilisateur  – symbolisé  par  son œil  dans 
Aladin - les observe depuis le haut, en transparence.

Types de plan

Les plans peuvent être de différents types suivant la nature 
des  données  qu’ils  contiennent.  Ils  sont  repérés  par  des 
logos spécifiques, facilement identifiables :

Pile et vue associée

Dans le cas le plus simple, la pile ne contient qu’une image 
avec  quelques  plans  catalogues  et/ou  surcharges 
graphiques centrés sur la même zone du ciel.  Il  est alors 
possible de créer une vue affichant l’image et les symboles graphiques en superposition.

Pour créer une vue, il y a deux méthodes :
 Soit en «  cliquant/glissant/déposant » le logo du plan depuis la pile vers la vue ;
 Soit simplement en « activant » le plan image concerné.

L’activation d’un plan se fait en cliquant sur la coche qui précède le logo du plan, ou sur 
le logo directement . Lorsqu’il est activé, le logo apparaît en grisé. 

En résumé, l’activation d’un plan image entraîne automatiquement la création d’une vue 
de représentation de cette image et active les plans graphiques qui peuvent s’y projeter. 
En revanche, l’activation/désactivation d’un plan graphique ne fera qu’afficher/cacher 
les objets concernés dans la vue courante.
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Lorsqu'il y a plusieurs plans simultanément activés, la coche du plan dont la solution 
astrométrique est utilisée pour les projections de la vue apparaît en rouge, les coches des 
autres plans apparaissent en noir.

Astuce : Il est possible de créer une vue uniquement basée sur un plan - catalogue, sans 
image  de  fond.  Pour  cela  vous  devez  utiliser  la  méthode  de  création  de  la  vue  par 
« cliquer/glisser/déposer » décrite ci-dessus. 

Un autre plan image du même champ pourra être inséré dans la pile afin de comparer 
ces  deux  images,  soit  par  semi  transparence  (voir  section  correspondante),  soit 
alternativement  en  activant  l’une  puis  l’autre  image,  soit  encore  en  créant  un  plan 
composite (fausses couleurs ou plans alternants (blink)). 

     

Il est également possible de charger simultanément dans la pile des plans images et/ou 
catalogues ne concernant pas la même position dans le ciel. La visualisation des deux 
zones du ciel pourra se faire soit alternativement en activant l’un puis l’autre des plans 
images concernés, ou simultanément en utilisant plusieurs vues affichées côte à côte (cf. 
5.1.2 - multivue).

Structuration hiérarchique

Afin de faciliter l’organisation de la pile, il peut être souhaitable 
de regrouper certains plans au sein d’un dossier, voire d’un sous-
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dossier.  La création d’un dossier se fait soit par le menu principal  « Edition », soit en 
utilisant le menu contextuel de la pile (clic droit ou CTRL clic).

Menu contextuel

La  pile  dispose  d’un  menu  contextuel  accessible  en  utilisant  le  bouton  droit  (resp. 
Pomme+clic pour Mac).  Ce menu regroupe l’ensemble des fonctions spécifiques à la 
manipulation  des  plans,  par  exemple  la  suppression,  ou  encore  l’affichage  des 
propriétés.

Sélection

La sélection d’un plan dans la pile se fait en cliquant sur son nom - et non pas sur son 
logo  (activation  du  plan).  Le  plan  sélectionné  apparaît  avec  un  fond  bleuté.  Il  est 
possible de  sélectionner plusieurs plans simultanément en maintenant la touche  Ctrl 
appuyée, ou Maj s’il s’agit d’un groupe de plans consécutifs. Certains éléments du menu 
principal,  ou  du  menu  contextuel,  ainsi  que  les  boutons  de  la  barre  d’outils  seront 
activés ou au contraire inhibés en fonction de la nature du ou des plans sélectionnés. Par 
exemple s’il s’agit d’un plan image, le bouton « contour » sera activé. 

Propriétés

Bouton : prop. 
Menu : Edition => Propriétés
Raccourci : Ctrl + Entrée

L’affichage  des  « propriétés »  d’un  plan  se 
fait  soit  par  le  bouton  « prop. »,  soit  par  le 
menu principal « Edition  => Propriétés » soit 
encore par le menu contextuel de la pile (clic 
droit  ou  CTRL  clic).  La  fenêtre  qui  s’ouvre 
présente à la fois les propriétés génériques : 
nom  du  plan,  origine  des  données…  mais 
également  les  propriétés  spécifiques  à  la 
nature  du  plan.  Cette  fenêtre  permet 
également  de  modifier  certaines  de  ces 
propriétés.  Par  exemple  il  sera  possible  de 
changer  le  symbole  graphique  utilisé  pour 
tracer  les  sources  d’un  catalogue  ou  encore 
d’ajuster  l’angle  de  rotation  d’un  champ  de 
vue  instrumental.  La  fenêtre  des  propriétés 
permet également de visualiser l’adresse Web 
utilisée par Aladin pour obtenir les données. 

Contrôle de la transparence

Certains plans peuvent être affichés en semi 
transparence sur l’image de fond. Ce peut être un plan catalogue ou qui contient un 
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champ instrumental (« FoV ») ou encore un plan «image» au-dessus d’une autre image. 
Lorsque cela est possible, le logo du plan en question est muni d’une petite languette. 
Celle-ci  peut  être  tirée  à  droite  pour  augmenter  le  niveau  d’opacité  du  plan,  ou  au 
contraire tirée à gauche pour la diminuer.

Astuce : le  niveau de  transparence  peut  également  être  contrôlé  dans  la  fenêtre  des 
propriétés du plan qui dispose d’une « tirette » plus large.

Diverses astuces

 En haut de la pile l’œil de l’observateur  est schématisé. Cet élément peut être 
cliqué afin de cacher d’un seul clic tous les plans graphiques et n’afficher que l’image 
de fond. Un deuxième clic sur l’œil rétablira la configuration précédente.

 Un plan catalogue sur le haut de la pile sera par défaut projeté systématiquement sur 
toutes les images de même champ situées en dessous de lui. Dans le cas du multivue 
(voir section suivante) il peut être intéressant de restreindre la projection d’un plan 
catalogue  à  une  image  particulière.  Pour  cela  il  suffit  de  placer  dans  un  même 
« dossier » le catalogue et l’image concernée. Puis via les « propriétés » associées au 
« dossier »,  sélectionner  « portée :  locale » :  le  dossier  apparaît  alors  comme  une 
enveloppe fermée et les catalogues qui s’y trouvent ne sont plus tracés sur les autres 
images.
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5.1.2 La vue

Le panneau de la vue (ou des vues) est l’élément principal de l’interface Aladin. La vue 
affiche une représentation des données activées dans la pile. En général, il s’agit d’une 
image  sur  laquelle  sont  dessinés  en  surimpression  des  symboles  graphiques 
représentant les sources des catalogues. Des éléments d’information situés sur les bords 
fournissent des informations complémentaires : une échelle, la taille du champ dans le 
ciel ainsi que son orientation par rapport au nord.

Position des objets

Pour  tracer  les  objets  astronomiques  à  leur  position  précise,  Aladin  se  base  sur  la 
solution  astrométrique  associée  à  l’image,  par  exemple  une  projection  tangentielle 
centrée. En général les images, notamment celles encodées dans le format FITS, sont 
fournies avec une solution astrométrique. Si ce n’est pas le cas - par exemple pour une 
image  JPEG fournie  par  l’utilisateur  -  il  est  possible  de  calculer  sa  propre  solution 
astrométrique (menu : Image => Calibration astrométrique – cf.5.8). Il est possible que les 
objets ne se superposent pas exactement à l’image soit parce que leurs positions sont 
imprécises, soit parce que la solution astrométrique est incertaine.

Activation des plans

Les plans qui s’affichent dans la vue sont ceux qui ont été activés dans la pile. Il est 
possible de cacher temporairement l’un ou l’autre des plans, voire même l’image de fond 
(cf. 5.1.1). 
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Passage à l’image suivante

Menu : Vue => Image suivante
Raccourci : Tab

Lorsque la pile contient plusieurs images, il  est possible de passer rapidement d’une 
image à l’autre en activant simplement le plan image correspondant. Automatiquement, 
tous les plans graphiques (catalogues et dessins) superposables à l’image seront activés. 
L’utilisation du menu « Vue => Image suivante » ou encore la touche « TAB » effectue la 
même opération. Cette fonctionnalité est particulièrement pratique lorsque la vue est 
visualisée en pleine écran ou en simple fenêtre (cf. ci-dessous).

Cube ou « séquence animée »

Dans le cas d’un « cube » d’images (cf. 5.10 - associations, ou cubes FITS), le plan de la 
pile  intègre  plusieurs  images  qui  seront  affichées  dans  la  vue  sous  forme  d’une 
« séquence animée », c'est-à-dire, image après image, avec un délai configurable par les 
propriétés  du  plan  (par  défaut  400ms).  La  vue  qui  visualise  un  cube  affiche  un 
contrôleur de défilement en surimpression de l’image. Celui-ci reprend les conventions 
des pictogrammes des lecteurs audio (pause, play, recul, avance…). Juste en dessous du 
contrôleur, une réglette visualise l’emplacement de l’image courante dans le cube. Cette 
réglette, tout comme le contrôleur, est manipulable via la souris.

Image en semi transparence

Il est également possible d’afficher une image en 
semi transparence sur une autre image. Ceci est 
notamment pratique lorsque l’image à afficher en 
transparence est plus petite que l’image de fond. 
Pour activer la semi transparence d’une image, il 
est  nécessaire  d’utiliser  la  petite  réglette  de 
couleur  magenta  qui  apparaît  sous  le  logo  du 
plan  image  projetable.  Lorsque  la  réglette  est 
totalement  tirée  à  droite,  l’image  du  dessus 
cachera totalement la portion correspondante de 
l’image du dessous.

Il peut être utile de permuter les plans images dans la pile pour modifier les images en 
avant-plan et en arrière-plan.

Réticule

Menu : Graphique => Réticule…

Le réticule permet de repérer une position particulière dans la vue. En général il s’agit de 
la dernière position cliquée. Le réticule peut être tracé soit sous la forme d’une petite 
croix de couleur magenta, soit comme deux droites se coupant transversalement. Il est 
également possible de ne pas l’afficher (menu Graphique => Réticule). Les coordonnées 
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du  réticule  s’affichent  dans  le  champ  « Position »  du  « bandeau  de  localisation ».  A 
l’inverse, la  saisie d’une position,  voire d’un nom d’objet,  dans ce champ entraîne le 
déplacement du réticule à la position correspondante.

Les 3 modes de la vue

Les actions opérées par la  souris  dans la vue dépendent du « mode » courant.  Trois 
modes exclusifs sont possibles :
 Select: pour sélection des surcharges graphiques dont les sources de catalogues ;
 Dépl. : pour déplacer le champ de vue ;
 Zoom : pour zoomer et dézoomer.

Par défaut, c’est le mode « Select » qui est activé. Avant d’opérer une action à la souris, 
jetez un coup d’œil à la barre d’outils pour vous assurer que vous êtes bien dans le mode 
souhaité.

Astuce :  Il suffit de sortir le pointeur de la souris hors de la vue pour revenir au mode 
par défaut « Select ».

Sélection d’objets  

Bouton : select  

Lorsque Aladin visualise des objets graphiques (sources de catalogues astronomiques ou 
surcharges graphiques), il est possible de sélectionner certains de ces objets lorsque le 
mode « Select » est activé. Si ce n’est pas le cas, cliquer sur le bouton « select » en haut de 
la barre des boutons. La sélection d’un objet se fait en cliquant dessus ou en créant un 
rectangle de sélection englobant l’objet ou les objets concernés (cliquez en dehors de 
tout objet, puis glissez et relâchez). Les objets sélectionnés sont entourés d’un petit carré 
vert.  S’il  s’agit  de sources astronomiques,  les mesures associées apparaissent dans le 
panneau des mesures sous la vue (cf. 5.1.6.).

Les objets sélectionnés - lorsqu’il s’agit de surcharges graphiques et non pas de sources 
de catalogues - peuvent être déplacés. Pour cela, il est nécessaire de cliquer/glisser l’un 
des petits carrés verts de contrôle qui se sont affichés lors de la sélection. De plus, s’il 
s’agit de champs instrumentaux (cf.  5.2.6 - FoV), les coins vont permettre d’effectuer 
une rotation.
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Glissement/déplacement  

Bouton : dépl.    
Menu : Edition => Glisser le champ de vue…
Raccourci : Alt+Z
Souris : bouton du milieu

Il  est  possible  de  faire  glisser  l’image  en  utilisant  le  bouton  « dépl. »  puis  en 
cliquant/glissant l’image dans la direction souhaitée.  Pour revenir rapidement au mode 
par défaut (Select) déplacez le pointeur de la souris hors du panneau de la vue.

Astuce: L'utilisation du bouton central de la souris permet d'effectuer directement un 
« Glissement/déplacement » tout en restant en mode « Sélect ».

Zoom  

Bouton : zoom  
Menu : Edition => Zoom…
Raccourci : F7, F8 -  F6 (zoom pointé)
Souris : molette

Aladin  permet  de  zoomer  rapidement  sur  une  portion  de  l’image.  Pour  garantir  de 
bonnes performances, seules les puissances de 2 sont possibles de 1/2048 à 2048x.  Le 
facteur 2/3 a été ajouté par commodité. En deçà du facteur ¼, un algorithme du pixel le 
plus  proche  est  utilisé  (image  très  « piquée »),  entre  ¼  et  2/3  Aladin  utilise  une 
moyenne, entre 2 et 2048, les pixels sont dupliqués (« gros pixels »).

Le facteur de zoom peut être modifié de différentes façons :
 En utilisant le bouton « zoom » puis en cliquant dans la vue (maintenir la touche Maj 

appuyée  pour  « dézoommer »).  Pour  revenir  rapidement  au  mode  par  défaut 
(« select ») déplacez le pointeur de la souris hors du panneau de la vue.

 En manipulant la molette de la souris avec le pointeur dans la vue
 En utilisant le menu contextuel à droite de la fenêtre
 En utilisant le menu principal « Edition => Zoom »

Si l’image dispose d’une calibration astrométrique, un accroissement du zoom centrera 
l’image sur la position courante du réticule (sauf si la vue a été « verrouillée » – cf. ci-
dessous). Il est ainsi très aisé de zoomer sur un objet particulier en déplaçant le réticule 
sur l’objet (simple clic), puis on utilisant la molette de la souris. 

Grille de coordonnées

Icône : grille   
Menu : Graphique => Grille
Raccourci : Alt+G

L’activation d’une grille se fait soit par l’icône « grille » se situant sous la vue, soit par le 
menu « Graphique => Grille ». Le pas de la grille est fonction du facteur de zoom courant 
pour n’afficher qu’un nombre raisonnable de secteurs. Le référentiel de la grille est le 
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même que celui  utilisé  pour afficher  la  position courante  sous la  souris.  Il  n’est  pas 
possible d’afficher simultanément plusieurs grilles dans des référentiels différents. 

Lorsque le facteur de zoom est très petit (1 /512x), la grille peut apparaître partiellement 
tronquée si  la  solution  astrométrique  de  l’image courante  ne  peut  être  utilisée  pour 
calculer une position très éloignée de l’image (ex : plaque de Schmidt digitalisée).

Flèche de la cible

Menu : Graphique => Flèche de la cible
Raccourci : Alt+T

Lorsqu’une image a été interrogée par position ou par nom d’objet (cf. 5.2 – le sélecteur 
de serveurs), une petite flèche rouge indique l’emplacement dans l’image. Celle-ci peut 
être effacée au moyen du menu « Graphique => Flèche de la cible ».

Vues multiples ou « multivue »

Afin de comparer facilement plusieurs images, il est pratique de créer simultanément 
plusieurs vues. Le panneau principal  peut ainsi  se subdiviser en 2, 4,  9 ou 16 sous-
panneaux.  Chacun de ces  panneaux peut  afficher  une image  différente  et  des  objets 
graphiques en superposition. Ces images peuvent concerner des régions différentes du 
ciel et/ou la même région du ciel. Il est également possible d’utiliser plusieurs panneaux 
pour une même image, par exemple pour visualiser plusieurs détails de celle-ci.
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Nombre de vues

Icône : multivues   
Menu : Vue => 1 panneau, 2 panneaux …
Raccourci : F1, Maj+F2, F2, F3, F4

La modification du nombre de vues « visibles » s’opère soit par le sélecteur « multivues » 
situé en bas à gauche sous le panneau des vues, soit par le menu « Vue => 1, 2, 4,9, ou 16 
panneaux ».  Dans le cas où il y aurait plus de vues utilisées que de panneaux disponibles, 
une barre de défilement apparaît à droite de la fenêtre principale permettant d’accéder 
aux autres vues. Il est possible de gérer plusieurs milliers de vues (cf. 6.5 – création de 
vues vignettes). Seules les vues visibles utilisent réellement de la mémoire vive.

Affectation des vues  
L’affectation  d’une  image  à  une  vue  se  fait  en  glissant/déposant  le  logo  du  plan 
correspondant de la pile dans le panneau choisi.  Il est également possible de créer en 
une unique manipulation autant de vues qu’il y a d’images dans la pile au moyen du 
menu « Vue => Créer une vue par image ». 

Astuce : Il est possible de glisser/déposer une image JPEG, PNG, GIF, FITS depuis votre 
environnement  de  travail  (Bureau  Windows,  Desktop  Linux…)  et/ou  depuis  votre 
navigateur Web vers une vue particulière.

Vue courante  
La vue courante est entourée d’un bord bleu, c’est-à-dire celle sur laquelle va s’opérer les 
fonctions de zoom par exemple. Il suffit de cliquer sur une vue pour qu’elle devienne la 
vue courante.  En maintenant  la  touche Maj  enfoncée,  il  est  possible  de  sélectionner 
plusieurs  vues  simultanément,  par  exemple  pour  indiquer  celles  qui  doivent  être 
supprimées. 

Il est possible de visualiser la vue courante (bord bleu) en « monovue » en revenant à un 
unique panneau. Les autres vues ne sont pas supprimées pour autant et sont toujours 
accessibles via la barre de défilement verticale qui apparaît à droite de la fenêtre ou en 
revenant en mode multivue.  La vue courante peut également être visualisée en plein 
écran (menu « Vue => Plein écran ») ou en mode simple fenêtre (menu « Vue => simple  
fenêtre ») – voir ci-dessous.
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Uniformisation des vues  

Icône : unif.   
Menu : Vue => Uniformiser…
Raccourci : Alt+S, Alt+Q

En  multivue,  il  est  possible  d’uniformiser  l’échelle,  voire  l’orientation  d’images 
différentes mais concernant la même région du ciel. Cette opération est accessible soit 
par  le  menu  « Vue  => Uniformiser  l’échelle »,  resp.  « Vue  => Uniformiser  l’échelle  et  
l’orientation ».  Soit,  dans  le  dernier  cas,  par  le  bouton « unif. ».  L’uniformisation  des 
échelles ne modifie pas les pixels, elle se contente de choisir automatiquement le centre 
et le facteur de zoom le plus proche pour visualiser la même zone du ciel. En revanche, 
l’uniformisation de l’échelle et de l’orientation reprojette les images en se basant sur la 
position des 4 coins de chaque image : les champs sont identiques mais les pixels sont 
déformés.  Les  vues  « uniformisées »  sont  automatiquement  sélectionnées,  repérables 
par  leur  bord  bleu.  Si  leur  orientation  a  également  été  alignée,  le  bord  des  vues 
concernées apparaît en rouge.

Vue verrouillée  
Menu : Vue => Vue verrouillée

Lorsque l’on double-clique dans une vue, toutes les autres vues concernant  la même 
région du ciel  vont se centrer  automatiquement sur la position cliquée.  Idem si l’on 
clique dans les mesures (cf.  5.1.6).  Pour inhiber ce changement de centrage et/ou un 
changement  accidentel  de  zoom,  il  est  possible  de  verrouiller  une  vue  pour  qu’elle 
conserve toujours le même centre et le même zoom (Menu « Vue => Vue verrouillée »). 
Une vue verrouillée fait apparaître un petit cadenas dans son coin bas gauche .

Panneau «     scotché     »  
Menu : Vue => Panneau scotché

Pour inhiber le défilement d’une ou plusieurs vues lorsqu’on utilise 
la barre de défilement verticale,  il  est possible de « scotcher » le 
panneau pour qu’il conserve sa place via le menu « Vue => Panneau 
scotché ».  Un  panneau  « scotché »  fait  apparaître  des  coins 
triangulaires rouges ; il n’est plus soumis à la barre de défilement.

Déplacement et copie
Il est aisé de déplacer une vue d’un panneau à un autre panneau en 
effectuant un simple cliquer/glisser/déposer à la souris. Le maintien de la touche Ctrl 
simultanément à cette opération entraînera la duplication de la vue.

Suppression
La suppression d’une vue n’entraîne pas pour autant la suppression de l’image et/ou des 
catalogues  utilisés  pour  cette  vue ;  les  données  restent  accessibles  dans  la  pile.  En 
revanche, la suppression d’une image dans la pile entraîne la suppression de toutes les 
vues qui l’utilisent. Le menu  « Vue  => Supprimer les autres vues » permet de supprimer 
rapidement toutes les vues exceptée la vue courante.
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Plein écran et simple fenêtre

Icon:  
Menu : Vue => Plein écran, Simple fenêtre
Raccourci : F11, F12

Une vue peut être affichée en utilisant la totalité de l’écran. Elle peut également n’utiliser 
qu’une  simple  fenêtre  sans  présenter  le  reste  de  l’interface  graphique  (menu,  pile, 
mesures….). L’utilisation de la touche « F11 », respectivement « F12 » va permettre de 
basculer  dans  ces  modes  de  visualisation.  La  touche  « Echap »  repassera  en  mode 
d’affichage normal.

A part la taille de la fenêtre d’affichage, ces deux modes sont identiques. L’utilisation 
d’Aladin en mode « plein écran » ou « simple fenêtre » diffère par quelques points de son 
usage normal :
 Des  icônes  de  manipulations  s’affichent  sur  le  bord  droit.  Elles  permettent 

d’activer ou non les catalogues et surcharges graphiques, d’afficher ou non la 
grille de coordonnées, de sauvegarder la vue courante en format PNG (ou JPEG 
avec  Maj appuyée – taille  plus petite  mais  moins nette  en cas de surcharges 
graphiques), de passer au champ suivant s’il y a lieu.

 L’icône  permet de rebasculer en mode normal (idem que la touche « Echap. »)
 Les informations de position et de valeur de pixel s’affichent en surimpression dans 

le coin haut droit de l’image
 L’utilisation de la souris associe à la fois le mode « Sélect. » et le mode « Dépl. » (cf. 

section suivante –  la barre des outils) .  Concrètement il est possible de déplacer le 
champ de vue en cliquant/glissant l’image. Il est également possible de sélectionner 
un objet en cliquant directement dessus.
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 On  ne  peut  sélectionner  qu’une  source  à  la  fois.  Ses  informations  de  mesures 
s’affichent en surimpression.

 Une commande script peut être saisie directement dans la vue. Elle s’affichera dans 
un cadre en surimpression.

 Si la pile est vide, un formulaire simplifié apparaît pour vous laisser saisir le nom 
d’un objet ou d’une position astronomique.

Astuce : Le mode « simple fenêtre » offre toutes les fonctions de base d’Aladin. Il peut être 
utilisé par défaut (cf.  8.1 –  les profils utilisateurs) et notamment si Aladin est utilisé en 
applet (cf. 7.2 – Aladin dans un navigateur Web)

5.1.3 La barre des outils

Située  entre  la  pile  et  la  vue,  verticalement,  la  « barre  des  outils »  permet  d’accéder 
rapidement aux outils les plus couramment utilisés : 

 select Mode : sélection des objets dans la vue
 dépl. Mode : déplacement de la vue
 zoom Mode : ajustement du zoom de la vue

 dist Surcharge graphique de mesures de distances
 dessin Surcharge graphique de dessin à main levée
 marq Surcharge graphique de positionnement de marque
 texte Surcharge graphique d’écriture de texte libre
 filtre Génération de filtres de catalogue
 corr. Outil de corrélation de catalogues
 rvb Générateur d’images couleur
 assoc Générateur d’associations d’images (mosaïques ou séquences animées)
 cont Générateur de contours
 loupe Activation/désactivation de la loupe
 pixel Ouverture de la fenêtre du contrôle de la dynamique des pixels
 prop Ouverture de la fenêtre des propriétés
 suppr Suppression de l’élément courant

Activation
Les boutons s’activent en fonction des plans sélectionnés dans la pile. Certains boutons 
restent en grisé s’ils ne sont pas concernés par le type de plan ou que le nombre de plans 
sélectionnés ne correspond pas à l’action à entreprendre.

Modes et outils
Les 3 premiers boutons concernent les modes d’action de la souris dans la vue pour 
sélectionner des objets, déplacer le champ de vue ou encore zoomer (cf. ci-dessus, les 3 
modes de la vue) . Il s’agit de boutons exclusifs.  Comme indiqué précédemment, il suffit 
de déplacer le curseur de la souris en dehors de la vue pour réactiver automatiquement 
le mode par défaut : « Select ».
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Tout les autres boutons concernent des outils. Nous ne détaillerons dans cette section 
que les outils qui n’ont pas été décrits dans les autres sections de ce document.

Les outils graphiques : dist, dessin, marq et texte

Menu : Graphique => dist, dessin, marq, texte
Raccourci : Alt+D (distance)

Les 4 boutons donnant accès aux outils graphiques de 
mesures  de  distances,  de  tracé  à  main  levé,  de 
placement de marques et de texte libre sont toujours 
activables.  L’activation  de  l’un  d’eux  entraîne  la 
création  automatique  d’un  plan  « surcharges 
graphiques »  sur  le  haut  de  la  pile.  Les  éléments 
graphiques  qui  seront  placés  à  la  souris  dans  la  vue 
seront  mémorisés  dans  ce  plan,  avec  des  coordonnées  célestes,  et  pourront  par 
conséquent être visualisés sur d’autres images.

Sélection et déplacement
Les surcharges  graphiques créées  par  l’un de ces 4 outils  peuvent  être sélectionnées 
(outil  Select), voire déplacées au moyen d’un cliqué/déplacé à la souris. Lorsqu’ils sont 
sélectionnés,  des petites  poignées vertes  apparaissent  sur  leur  pourtour  ou sur leurs 
extrémités.  

Détail technique : Lorsque plusieurs éléments sont déplacés simultanément, il faut noter 
que le déplacement est calculé sur la voûte céleste (en RA, DEC) uniquement pour l’objet 
sous la souris, puis reporté aux autres objets concernés. Le maintien de la touche Maj 
change ce comportement pour ne considérer qu’un mouvement en coordonnées XY pour 
tous  les  objets.  Ces  deux  techniques  ne  donnent  pas  le  même  résultat  notamment 
lorsque les objets à déplacer sont distants de plusieurs degrés ou proche des pôles.

Quelques astuces
 Lors d’un marquage (outil  « marq. »), le maintien de la touche « Maj » entraîne le 

calcul  automatique d’un « centroïde » des valeurs des pixels au plus proche de la 
position cliquée, et le déplacement de la marque à la position trouvée. Ceci permet de 
placer facilement une marque au centre d’une étoile ;

 Il  est  possible  de  faire  apparaître  à  côté  d’une  marque  sa  position.  Pour  cela 
sélectionnez la marque en question et utilisez le menu contextuel (clic droit ou CTRL 
clic) et sélectionnez « afficher l’identificateur de l’objet ». 

 Lors  d’un  dessin  à  main  levé  (outil  « dessin »)   il  est  possible  soit  de  maintenir 
enfoncé le bouton de la souris pour effectuer un dessin « en continu », soit de cliquer 
plusieurs fois afin de tracer des lignes droites successives. Dans ce dernier cas, il est 
nécessaire de sortir le pointeur hors de la vue pour stopper le processus de dessin ou 
de double-cliquer pour le dernier sommet.

 Pour créer un nouveau plan afin que les nouvelles surcharges graphiques ne soient 
pas dans le même plan graphique, il est nécessaire de maintenir la touche « Maj » 
appuyée lors de l’activation de l’outil.
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Graphe de coupe associé à l’outil de distance  
Lorsque  la  double  flèche  utilisée  pour  mesurer 
une  distance  a  été  sélectionnée  dans  la  vue,  le 
panneau du zoom - en bas à droite de la fenêtre 
principale  -  est  remplacé  par  un  « graphe  de 
coupe »  représentant  la  répartition  des  valeurs 
des  pixels  le  long  du  segment  mesurant  la 
distance. Si ce segment est déplacé dans la vue au 
moyen de la souris, le graphe de coupe évolue en 
fonction  de  la  position  dans  l’image.   D’autre 
part, si vous survolez le graphe de coupe avec la 
souris, une barre horizontale rouge permet de calculer la distance, angulaire et en pixels, 
d’un pic particulier. Cette méthode permet par exemple d’effectuer une approximation 
rapide d’une largeur à mi-hauteur pour une étoile. 

D’autre part, dans le cas d’une image en vraies couleurs (cf. 8.2 – types de données 
supportés), ce sont les niveaux des 3 composantes Rouge/Vert/Bleu qui seront 
simultanément tracés. 

Coupe en profondeur associée à l’outil «     Marq.     »  
Le positionnement et  la  sélection  d’une marque  (par  l’outil  « Marq »)  dans  un  cube 
d’images génère également un graphe de coupe, mais cette fois-ci  dans le sens de la 
profondeur du cube. Sur le graphe ainsi obtenu, le trait vertical rouge correspond à la 
position de l’image courante du cube (un cube sous Aladin est  visualisé comme une 
séquence d’images).  La valeur mentionnée au pied de ce  repère indique la  grandeur 
physique correspondant à l’image courante du cube (par exemple une vitesse). Comme 
pour  l’outil  distance,  le  déplacement  à  la  souris  de  la  marque  entraîne  l’ajustement 
automatique du graphe. D’autre part, le survol du graphe par la souris affiche la valeur 
du pixel correspondant (ordonnée du graphe). Un cliquer/glisser horizontal va déplacer 
la ligne rouge de l’image courante et de ce fait faire évoluer l’image courante dans la vue. 
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Mesures de photométrie associées aux outils «     Marq.     » et «     Dessin     »  
Les outils « Marq. » et « Dessin » lorsqu'ils sont utilisés pour définir une surface (cliquer 
–  déplacer  via  l'outil  « Marq. »  afin  de  tracer  un  cercle,  polyligne  fermée  via  l'outil 
« Dessin ») engendrent le calcul de 5 mesures statistiques sur les pixels englobés : la 
somme, la moyenne, la médiane, le sigma et la surface angulaire. La sélection de l'objet 
fait apparaître les mesures directement dans la vue, un zoom sur la zone va mettre en 
évidence les pixels concernés au moyen de petits carrés.

L’outil « loupe »

Bouton : loupe
Menu : Image => Loupe, Table de pixels
Raccourci : Ctrl+G

Lorsque la loupe est activée,  le panneau du zoom – en bas à 
droite de la fenêtre principale – va être temporairement utilisé 
afin d’afficher un agrandissement des pixels se situant autour 
du pointeur de la souris lorsque celui-ci survole la vue.
L’utilisation  des  touches  de  déplacement  (flèches  Haut,  Bas, 
Droite, Gauche) devient possible pour effectuer un déplacement 
pixel par pixel du pointeur de la souris.

De même, l'utilisation des touches « + » 
et  « - »  permet  d'augmenter,  respectivement  de  diminuer  le 
grossissement de la loupe. Lorsque le grossissement est suffisant, 
les valeurs des pixels sont directement affichées en superposition 
des pixels.
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L’outil « suppr »

Bouton : suppr
Menu : Edition => Supprimer

Edition => Tout supprimer
Raccourci : Suppr ou  Maj+Suppr

L’outil  de suppression est  fortement dépendant  du contexte.  En fonction du,  ou des 
éléments sélectionnés par la souris, il supprimera, soit :
 La – ou les -  surcharges graphiques ;
 La – ou les – vues ;
 Le – ou les – plans.

D’autre part, la pression simultanée de la touche « Maj » entraînera la suppression de 
toutes les données chargées dans Aladin. A manier à bon escient car Aladin ne dispose 
pas d’une fonction « annuler » (« undo »).

Les autres outils accessibles par la barre des outils sont détaillés dans les autres sections 
de ce document.

5.1.4 Le panneau du zoom

Le « panneau du zoom », en bas à droite de la fenêtre principale, représente une vignette 
dessinant la totalité  de l’image de la vue courante sur laquelle  se superpose en semi 

transparence  un  rectangle  bleuté.  Ce  rectangle  représente  la 
partie  visible  dans  la  vue par rapport  à  l’image  globale.  Elle 
permet de se repérer en un coup d’œil. 

Le rectangle peut être déplacé au moyen de la souris. La vue 
évolue  automatiquement  pour  dévoiler  la  portion  de  l’image 
correspondante. Si la zone visible est totalement en dehors de 
l’image,  une  petite  flèche  rouge  indique  la  direction 
correspondante.

Les informations en surimpression donnent la taille angulaire de l’image globale.

Le facteur de zoom courant peut être modifié facilement au moyen de la molette de la 
souris. Pour recentrer rapidement la vue à la taille maximale, il suffit de cliquer dans la 
vignette en maintenant appuyé la touche Ctrl.
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5.1.5 Le bandeau de localisation

En haut de la fenêtre principale, sous le menu, deux champs permettent d’afficher la 
position courante et la valeur du pixel dans la vue à l’emplacement de la souris. Chacune 
de ces informations peut être affichée dans un système de référence particulier spécifié 
dans le menu déroulant qui est placé immédiatement à la suite de chacun des champs. 

La position

La position peut être fournie en coordonnées célestes ou en abscisse/ordonnée d’ans 
l’image.  Les  référentiels  célestes  disponibles  sont  ICRS,  J2000,  B1950,   Ecliptique, 
Galactique, Supergalactique. Suivant les cas, l’affichage peut être donné en sexagésimal 
ou en décimal.

La précision d’affichage s’adapte en fonction du facteur de zoom courant.

Note  :  Le  système  de  référence  courant  est  pris  en  compte  non  seulement  pour 
l'affichage des coordonnées mais également pour leur saisie dans les divers formulaires 
d'Aladin.

La valeur du pixel

La valeur du pixel peut être fournie sous trois formes :
 8 bits :  Le niveau « monochrome » (généralement en gris)  utilisé  pour l’affichage 

courant.  Il  s’agit  d’une  valeur  entre  0  et  255  qui  dépend  essentiellement  des 
paramètres  de  choix  de  contraste.  Si  l’image  est  fournie  en  JPEG,  seul  ce  mode 
d’affichage sera possible ;

 Raw file : La valeur utilisée pour le codage du pixel dans le fichier de l’image ;
 Full : La valeur « physique » du pixel. Cette valeur est obtenue à partir de la valeur de 

codage (raw)  multipliée  par  un facteur  indiqué avec l’image  (BSCALE – selon le 
format FITS) décalée d’une origine (BZERO).  C’est cette dernière valeur qui est la 
plus significative et qui est celle affichée par défaut (Full = raw*BSCALE + BZERO). 
Si ces paramètres sont inconnus, la valeur « Full » du pixel sera identique à la valeur 
« Raw ».

Mémorisation de l’information courante

Les  valeurs  du  bandeau  d’information  sont  continuellement  modifiées  suivant  les 
mouvements de la souris. Cependant, un clic souris dans la vue mémorisera les valeurs 
courantes (position + pixel) qui apparaîtront un bref instant en couleur magenta. Ces 
valeurs seront mémorisées dans les champs « Position » et « Pixel » et seront réaffichées 
lorsque la souris entrera dans le champ correspondant. Elles pourront ainsi être copiées 
dans le presse-papier afin d’être collées dans une autre application.
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Saisie d’une position, d’un nom d’objet

Menu : Outil => Résolution d’un nom d’objet …
Raccourci : Ctrl+R

Il  est  possible  de  saisir  une  position  directement  dans  le  champ  « Position ».  Le 
référentiel utilisé doit correspondre à celui spécifié (J2000, B1950d, XY image,…). La 
validation de la position saisie par la touche Entrée entraîne le déplacement du réticule 
(croix magenta) à la position correspondante dans la vue ainsi que le centrage de la vue 
sur cette position. Cette position peut éventuellement se situer en dehors de l’image.

Il est également possible de saisir un identificateur d’objet astronomique. Dans ce cas la 
validation (touche Entrée) entraînera dans un premier temps l’interrogation automatique 
du service « Sésame du CDS » qui retourne la meilleure position connue de l’objet en 
consultant  les  bases  de  données  Simbad,  NED et  certains  grands  catalogues 
astronomiques de VizieR.  Puis,  en  se  basant  sur  les  coordonnées récupérées,  Aladin 
déplacera  le  réticule  et  centrera  la  vue sur  la  position.  Cette  fonction  est  également 
accessible via le menu « Outil => Résolution d’un nom d’objet ».

Astuce : Dans  le  cas  où  la  vue  est  encore  vide,  la  saisie  d’une  position  ou  d’un 
identificateur d’objet astronomique entraîne la création de 3 plans par l’interrogation 
automatique d’un serveur d’image DSS (par défaut celui fourni par le CDS), de Simbad 
et de NED.

Commande script  
Le  champ  position  peut  être  également  utilisé  pour  saisir  n’importe  quelle  autre 
commande script, et pas uniquement une position (cf. 7.1 – Aladin par script)

Intéressons-nous maintenant au bas de la fenêtre principale : le « panneau des mesures ».

5.1.6 Les mesures

Le « panneau des mesures » se situe en bas de la fenêtre principale d’Aladin.  Il  sert  à 
visualiser les mesures associées aux sources. C’est un outil très puissant qui permet de 
sélectionner, de trier, de filtrer des tables.

Seules les sources qui ont été sélectionnées, individuellement ou collectivement, dans la 
vue au moyen de la souris (cf.  5.1.2) apparaissent dans le panneau des mesures. Ces 
mesures sont présentées sous forme d’une table où chaque ligne correspond aux valeurs 
associées à une source.

Les sources sélectionnées apparaissent entourées  d’un carré vert dans la vue. Le survol 
par la souris d’une source sélectionnée fait clignoter cette source et simultanément, rend 
visible  les  mesures  correspondantes  en  surlignant  la  ligne  en  bleu.  De  manière 
symétrique,  le  survol  d’une  ligne  dans  la  table  des  mesures  fait  clignoter  la  source 
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correspondante dans la vue si elle est visible. D’autre part, la sélection d’une ligne de la 
table  (en double-cliquant  dessus)  va déplacer  la  vue afin  de la  centrer  sur  la  source 
correspondante.

La première ligne de la table affiche l’en-tête qui décrit le contenu de chaque colonne. 
Cliquer sur une case d’en-tête entraîne le tri, en ordre croissant, puis décroissant, des 
lignes en fonctions des valeurs de la colonne.  Un petit triangle apparaît  à droite du 
libellé pour indiquer la colonne de tri. Le tri sera alphabétique ou numérique suivant le 
contenu de la colonne. Il est possible d’agrandir ou de rétrécir la largeur d’une colonne 
en cliquant/déplaçant le bord droit d’une case de l’en-tête. Lorsqu’une case est tout de 
même trop étroite pour afficher la totalité de la valeur, le déplacement de la souris sur 
cette case l’agrandit temporairement afin de dévoiler le reste de la valeur.

    

Mesures issues de catalogues différents

Si  les  sources  sélectionnées  sont  issues  de catalogues  différents,  plusieurs  tables  qui 
n’ont pas nécessairement les mêmes colonnes vont se succéder. La couleur du carré en 
début de ligne permet rapidement de repérer l’origine des données (même couleur que 
le plan dans la pile). 

La  ligne  d’en-tête  correspond  toujours  à  la  table  de  la  dernière  ligne  sélectionnée 
(cliquée via la souris), ou à défaut, à celle pointée sous la souris. La couleur du trait sous 
l’en-tête reprend la couleur du catalogue correspondant. 

Liens et boutons

Comme dans un navigateur Web, les valeurs soulignées en bleu sont des « liens » vers 
des informations supplémentaires disponibles sur le net. L’adresse Web qui sera appelée 
s’affiche en bas de la fenêtre d’Aladin lorsque le pointeur de la souris survole le lien. Un 
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clic souris sur un lien ouvre votre navigateur Web et lui demande de charger la page 
Web correspondante.
En règle  général,  le  premier  lien  d’une  ligne  de  mesure  va charger  l’enregistrement 
original du site Web qui a fourni le catalogue (Simbad, NED, VizieR…)

Certaines valeurs peuvent également être représentées sous forme d’un bouton. Tout 
comme un lien Web, l’activation d’un tel bouton entraînera le chargement de données 
complémentaires via le net. Cependant, au lieu d’ouvrir votre navigateur, les données 
récupérées vont être insérées dans la pile afin d’être visualisable immédiatement dans 
Aladin. Le plus souvent il s’agit d’images d’archives associées à une liste d’observations.

Fenêtre indépendante

Le panneau des mesures peut être détaché de la fenêtre principale en cliquant sur le logo 
en haut  à  droite  .  Ceci  permet d’une part  de bénéficier  d’un plus large  espace  de 
travail pour la vue et d’autre part, de travailler plus aisément sur un plus grand nombre 
de mesures. Notez que la table des mesures d’Aladin peut afficher sans souci plusieurs 
centaines de millier de lignes.  La réintégration de la fenêtre des mesures à sa place 
initiale se fait simplement en cliquant à nouveau sur le même logo, ou en fermant la 
fenêtre.

Sélections des sources

La sélection des sources peut être effectuée soit par menus, soit par la souris, soit par 
une expression de recherche.

Sélection par menus
Menu : Edition => Sélectionner …
Raccourci : Ctrl+A (tous les objets)

Le menu « Edition » propose un sous-menu pour sélectionner toutes les sources, c’est-à-
dire toutes les sources présentent dans les plans catalogues chargés dans la pile. Il est 
également  possible  de  ne  sélectionner  que  les  sources  d’un  ou  de  certains  plans 
spécifiques via le menu « Edition => sélectionner tous les objets des plans sélectionnés ». Il 
aura fallu au préalable sélectionner les plans en question dans la pile (cf. 5.1.1).

Sélection par la souris
La sélection par la souris est la méthode la plus courante. Elle permet de choisir des 
sources en fonction de leurs positions dans la vue.
 Pour sélection une source il suffit de cliquer dessus dans la vue ;
 Pour  sélectionner  plusieurs  sources il  est  nécessaire  de  les  englober  dans  un 

rectangle de sélection. Pour cela, il faut cliquer sur une zone sans source légèrement 
au-dessus à gauche de la première source à sélectionner, puis tout en maintenant 
enfoncé le bouton de la souris, étendre la sélection en déplaçant le pointeur de la 
souris vers le bas à droite. Lors de cette opération, un rectangle montre sur la vue la 
zone de sélection. Lorsque vous relâchez le bouton de la souris, toutes les sources à 
l’intérieur du rectangle seront sélectionnées ;
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 Pour ajouter des sources à une première sélection, procéder comme précédemment, 
mais en maintenant enfoncée la touche Maj.

Sélection par expression de recherche  
Menu : Edition => Chercher dans les catalogues chargés …
Raccourci : Ctrl+F

Aladin offre une méthode très efficace  pour sélectionner  les  sources en fonction des 
valeurs  de  leurs  mesures.  Pour  cela  il  est  nécessaire  de  saisir  une  expression  de 
recherche dans la petite  boîte « Chercher »  qui  se trouve juste au-dessus à droite  du 
panneau des mesures.

La validation de l’expression de recherche par la touche « Entrée » ou en cliquant sur le 
petit  bouton « Go » entraîne la sélection de toutes les sources dont une des mesures 
répond à l’expression de recherche.  Seules les sources des plans catalogues activés 
vont être concernées (cf.  5.1.1 -  activation d’un plan dans la pile).  Si  l’expression de 
recherche est précédée du caractère ‘+’,  les sources à sélectionner vont s’ajouter à la 
sélection  courante.  De  manière  opposée,  la  présence  du  caractère  ‘-‘  en  début 
d’expression de recherche entraînera la desélection des sources concernées parmi les 
sources préalablement sélectionnées, c’est-à-dire qu’elle les fera disparaître de la tables 
des mesures.

L’expression de recherche suit une syntaxe simple et efficace.
Ce peut être : 
 une chaîne de texte ;
 incluant  éventuellement  des  caractères  jokers : ‘?’  (n’importe  quel  caractère),  ‘*’ 

(n’importe quelle suite de caractères) ;
 éventuellement précédé d’un nom de colonne et d’un opérateur de test (=, !=, <, >, 

<=, >=)  pour restreindre la recherche à une colonne particulière ;
D’autre part :
 le nom de colonne peut inclure des caractères jokers (‘ ?’ ou ‘*’) ;
 le nom de colonne peut être encadré par deux barres verticales ‘|’ pour indiquer la 

valeur absolue ;
 il n’y a pas de distinction entre majuscules et minuscules que ce soit pour le nom de 

la colonne ou pour la valeur.

Remarque : par commodité, la recherche d’une chaîne de texte simple sans indication 
de colonne particulière est toujours considérée comme une sous chaîne à rechercher. Par 
exemple : la recherche « gal »  sera de fait « *gal* ».

Quelques exemples :
 Star les sources dont les mesures comportent le mot « star »
 otype=uv les sources dont la colonne « otype » a la valeur « uv »
 mag*>=12 première  colonne dont  le  nom commence par  « mag »,  la  valeur 

numérique doit être supérieure ou égale à 12
 |pm*|<5 même principe que précédemment mais seule la valeur absolue est 

prise en compte
 type!=g* colonne « type » dont les valeurs ne commencent pas par la lettre ‘g’
 bmag!="" colonne « bmag » non vide
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Désélection
Menu : Edition => Désélectionner les objets …
Raccourci : Ctrl+U

 Pour désélectionner une source d’une sélection précédente, cliquez sur la source en 
question en maintenant appuyée la touche Maj

 Pour désélection toutes les sources – ce qui revient à « vider » la table des mesures - 
il  suffit  de cliquer dans la vue n’importe où en dehors de toute source ou encore 
d’utiliser le menu « Edition => désélectionner toutes les sources ».

Astuce :  Pour  éviter  de  « perdre »  accidentellement  une  sélection,  vous  pouvez 
« cocher » les sources de votre table afin de pouvoir les resélectionner ultérieurement 
(cf. paragraphe ci-dessous).

Compteurs
Le  rapport  du  nombre  de  sources  sélectionnées  (c'est-à-dire  dont  les  mesures  sont 
affichées) sur le nombre total de sources apparaît dans le compteur en bas à droite de la 
fenêtre d’Aladin.

Navigation dans les mesures

L’exploration des mesures, et notamment la visualisation rapide de la source associée, 
passe  par  la  sélection  d’une  ligne  particulière  de  la  table  des  mesures.  La  ligne 
sélectionnée apparaît en fond bleuté « fixé sur la ligne » même si la souris ne s’y trouve 
pas.

La sélection d’une ligne de mesures se fait soit manuellement au moyen de la souris soit 
par expression de recherche.

Sélection d’une ligne de mesure par la souris
La sélection par la souris se fait soit dans le panneau des mesures par un simple clic 
souris (hors d’un lien Web ou d’un bouton), soit dans la vue en cliquant sur une source 
sélectionnée (carré vert). Cela entraîne le déplacement du réticule (croix magenta) sur la 
source correspondante.  Et dans le cas où la sélection s’est faite  via le tableau via un 
double-clic il y a centrage automatique de la vue sur la source (à moins que la vue n’ait 
été « verrouillée » - cf. 5.1.2).

Rappel : pour réafficher la totalité de l’image dans la vue, Ctrl + clic dans le panneau du 
zoom.

Sélection d’une ligne de mesure via une expression  
La  boite  de  saisie  utilisée  pour  sélectionner  les  sources  permet  également  de 
sélectionner une ligne particulière de mesures. Ainsi La saisie d’une expression - SANS 
effectuer la validation (ni Entrée, ni bouton « Go ») - et l’usage des deux flèches à 
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droite  de  la  boite  de  saisie  permet  de  sélectionner  la  ligne  suivante/précédente  des 
mesures correspondante à l’expression.  Les touches « flèche HAUT » « flèche BAS » , ou 
la  molette de  la  souris  permet  également  de  passer  à  la  mesure  suivante,  resp. 
précédente. Comme pour la sélection via la souris, la vue se centre automatiquement sur 
la source correspondante. Si l’expression est vide, ce sera la ligne suivante ou précédente 
qui sera simplement sélectionnée.

Désélection
La desélection de la ligne se fait par simple clic dans le panneau des mesures (en dehors 
d’un lien Web ou d’un bouton).

Comportements inhibés
Lorsqu’une ligne de mesure est sélectionnée, certains comportements automatiques sont 
inhibés :
 L’en-tête du panneau des mesures reste celui associé à la ligne sélectionnée même si 

la souris se déplace hors de la ligne en question (ceci permet notamment d’effectuer 
un tri sur cette table) ;

 Le déplacement de la souris, dans la vue, sur les autres sources sélectionnées ne fera 
plus défiler les mesures associées.

Coche sur les mesures

Menu : Edition => Cocher …, Décocher…
Menu contextuel : Cocher…, Décocher…, Garder…

Un petit carré de couleur apparaît à gauche de chaque ligne de 
mesures.  Il  permet  non  seulement  de  repérer  l’origine  des 
données  par  le  code  couleur,  mais  également  de  « cocher » 
certaines lignes et, de ce fait les sources correspondantes, afin 
de les retrouver aisément ultérieurement.

Deux menus permettent de manipuler les sources « cochées » : 
 Le menu contextuel qui apparaît directement dans le panneau des mesures (clic droit 

ou CTRL clic) :

 Le menu principal « Edition » :

Dans la vue, les sources dont les lignes des mesures sont cochées apparaissent avec un 
carré magenta à la place du carré vert habituel. 
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Ajouter/calculer une nouvelle colonne

Aladin offre la possibilité d’ajouter une nouvelle colonne de valeurs. Cette opération est 
décrite en détail dans la section 5.7.

Exporter des mesures

Menu : Catalogue  => Créer un nouveau plan avec …
Menu contextuel : Créer un nouveau plan avec  …

Les  mesures  peuvent  être  facilement  copiées  dans  le  « presse-papier »  du  système 
d’exploitation afin de les « coller » dans une autre application. Le menu contextuel du 
panneau des mesures offre plusieurs possibilités :

Il est également possible de générer un nouveau plan catalogue qui contiendra une copie 
des sources/mesures présentent dans le panneau des mesures via le menu contextuel 
« Créer  un  nouveau  plan  avec  ces  sources »  ou le  menu principal « Menu  => Créer  un 
nouveau plan avec les objets sélectionnés ».

Après avoir détaillé les différents composants de la fenêtre principale, intéressons-nous 
à la deuxième fenêtre la plus utilisée dans Aladin : le « Sélecteur de serveurs ».

5.2 Le sélecteur de serveurs
Icône : .
Menu : Fichier => Ouvrir…, Fichier => Charger …
Raccourci : Ctrl+O

La fenêtre du « sélecteur de serveurs » permet de connaître et d’interroger les différentes 
bases de données astronomiques accessibles par Aladin. 

Elle  s’ouvre  soit  par  le  bouton   en  haut  à  gauche  soit  par  l’un  des  menus  de 
chargement de données (menu « Fichier… )

Cette  fenêtre  se  présente  sous  la  forme  de  plusieurs  formulaires  d’interrogations 
sélectionnables au moyen d’onglets. Les onglets à gauche de la fenêtre concernent les 
serveurs d’images,  ceux à  droites  les  serveurs de données tabulaires,  notamment les 
catalogues astronomiques et les listes d’observations des télescopes (« logs »). Enfin, les 
onglets se situant en haut concernent certains formulaires spéciaux qui seront détaillés à 
la fin de cette section. 
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Ces onglets et formulaires peuvent évoluer au cours du temps en fonction  des nouvelles 
possibilités  offertes  par  la  communauté  astronomique.  A  chaque  démarrage,  Aladin 
accède à un mécanisme de « pages jaunes » des services astronomiques disponibles afin 
de se mettre à jour et ajoute des onglets et/ou modifie les formulaires correspondants 
lorsqu’il détecte des changements (cf. détails techniques du « cache » en Erreur : source
de la référence non trouvée).

5.2.1 Liste des serveurs

Vous  y  trouverez  la  plupart  des  centres  astronomiques  mondiaux  distribuant  leurs 
données sur Internet. Il faut noter que certaines données étant distribuées par plusieurs 
instituts il est possible d’y accéder par différents serveurs (ex : 3 serveurs pour le DSS).
La liste des serveurs est décrite en détails dans la FAQ d’Aladin à l’adresse suivante : 
http://aladin.u-strasbg.fr/java/FAQ.html#data

5.2.2 Saisie des informations

La  plupart  de  ces  formulaires  nécessitent  la  saisie  d’au  moins  deux  éléments 
indispensables à une interrogation du ciel par cône, à savoir une position et un rayon :
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Saisie de la position

La  position  peut  être  soit  une  identificateur  d’objet  astronomique  reconnu  par  le 
mécanisme  Sesame  du  CDS  (recherche  dans  Simbad  +  NED  +  quelques  grands 
catalogues),  soit  des  coordonnées  astronomiques  exprimées  en  sexagésimal  dans  le 
référentiel J2000.

Quelques exemples:
M1
NGC2045
Galactic center
2 31 59 +89 15 54
12:59:48.70 +27:58:50.0

Saisie du rayon

Le rayon d’interrogation correspond au rayon du cône d’interrogation sur le ciel. Cette 
valeur peut être suivi d’une unité (« ° », « ' » « "»  ou « deg », « arcmin », « arcsec »). 
L’unité par défaut est la  minute d’arc.  Il  est  également possible d’indiquer une zone 
rectangulaire en utilisant la syntaxe suivante : W x H où W et la largeur du rectangle en 
ascension droite et H la hauteur du rectangle en déclinaison. Ces deux valeurs peuvent 
être  suivies  par  une  unité.  Dans  le  cas  où  le  serveur  interrogé  ne  supporte  que 
l’interrogation par cône (resp. par rectangle), Aladin choisira toujours une zone couvrant 
totalement le champ désigné (cercle englobant, resp. rectangle englobant).

Quelques exemples
14
9.14’
20arcmin
10’ x 12’
1°

Saisie automatique

Dans le formulaire courant, la position et le rayon sont automatiquement renseignés en 
fonction des données précédemment chargées afin de couvrir le même champ sur le ciel. 
Il est également possible de désigner explicitement une zone du ciel sur une image déjà 
chargée au moyen du bouton « pointer » qui apparaît derrière le champ de saisie de la 
position. Aladin vous invite à désigner la zone en cliquant/glissant/relâchant dans la 
vue.

Lors du passage d’un formulaire à un autre via les onglets, les valeurs indiquées dans le 
premier formulaire seront conservées dans le second formulaire.
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5.2.3 Liste et arbre de données

Certains serveurs  nécessitent 2 étapes pour charger les données : tout d’abord désigner 
la  zone  du  ciel,  puis  pour  sélectionner 
parmi  les  images  ou  catalogues 
disponibles  ceux  que  vous  souhaitez 
charger.  Lors  de  la  deuxième  étape, 
Aladin  affiche  les  données  disponibles 
sous la forme d’une liste ou d’un arbre. 
Cette liste/arbre dispose de nombreuses 
fonctions :
 Le  déplacement  de  la  souris  sur  un 

élément  affiche  dans  la  fenêtre 
principale  le  ou  les  champs  de  vue 
correspondants ;

 Lorsque les données sont sous forme d’arbre, un clic droit fait apparaître un sous-
menu de contrôle de l’arbre ;

 Lorsque les données sont sous forme de liste, il est possible de les trier en cliquant 
sur l’en-tête des colonnes ;

 Un clic sur un élément affiche les informations relatives à cette donnée ainsi que 
certains paramètres d’interrogations spécifiques ;

 Chaque élément est précédé d’une case à cocher qui permet de désigner plusieurs 
éléments  à  charger.  Ces  cases  peuvent  être  cochées  soit  manuellement  soit  en 
cliquant  dans  la  vue  afin  de  ne  désigner  que  les  éléments  qui  contiennent 
explicitement la position cliquée.  Le bouton « Réinit. » permet de dé-sélectionner 
toutes les coches. Le bouton « Effacer » supprime la liste / l’arbre.

5.2.4 Historique des requêtes

Menu : Fichier => Historique …
Raccourci : Ctrl+H

Au fur et à mesure de la session, Aladin mémorise toutes les informations issues des 
différents serveurs de données qui ont été interrogés. Pour cela il  construit  un arbre 
dont les branches principales sont les différentes cibles qui ont été « visitées » lors de la 
session en « greffant » les divers résultats intermédiaires. Vous pouvez parcourir, voire 
réutiliser cet arbre de données via le menu « Fichier => Historique ». 
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5.2.5 Le bandeau de contrôle

Le serveur de sélecteur fait apparaître dans sa partie inférieure un bandeau de contrôle 
commun à tous les formulaires.

 Effacer : Efface tous les champs de saisie du formulaire courant ;
 Réinit. :  Réinitialise  le  formulaire  courant  en  remettant  les  valeurs  par  défaut, 

notamment  la  position  et  le  rayon  correspondant  aux  données  précédemment 
chargées ;

 Aide : Affiche un panneau d’aide sur l’utilisation de la fenêtre ;
 CHERCHER : lance la requête du formulaire courant ;
 Fermer : Ferme la fenêtre.

5.2.6 Les 4 formulaire des onglets « du haut »

En haut de la fenêtre sont regroupés certains formulaires spéciaux.

« File » - Accès local ou par URL.

Ce formulaire permet de charger des données personnelles, soit via des fichiers locaux, 
soit  via  une  adresse  Web  (url).  Il  peut  s’agir  de  n’importe  quel  type  de  données 
supportées  par  Aladin (cf.  8.2).  Le  bouton « Parcourir »  permet  de  naviguer  dans  le 
sélecteur de fichier de votre système d’exploitation afin de désigner le fichier concerné.

Astuce :  Les  données  locales  peuvent  également  être  chargées  en  cliquant/déplaçant 
l’icône  d’un  fichier  depuis  une  fenêtre  de  votre  bureau  ou  de  votre  gestionnaire  de 
fichier, dans la fenêtre Aladin. Idem pour les images ou liens affichés dans un navigateur 
Web.
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Astuce : Dans  le  cas  où  il  s’agit  d’un  nom  de  répertoire  local,  Aladin  va  scanner 
l’ensemble du contenu du répertoire et de ses sous-répertoires et en construire un arbre 
de données disponibles. Il laissera un fichier nommé « .aladin_idha » qui lui permettra 
de recharger rapidement cette description lors d’une autre utilisation.

« All VO » – Tout le VO en un seul clic !

Cet  onglet  permet 
d’interroger  simultanément 
tous  les  serveurs  connus 
d’Aladin, non seulement ceux 
présents à droite et à gauche 
de  la  fenêtre  mais  tous  les 
autres  serveurs  décrits  dans 
les  « pages  jaunes »  de 
l’Observatoire  Virtuel.  Le 
formulaire  permet  de 
restreindre  l’interrogation 
aux  serveurs  d’images  et/ou 
aux  serveurs  de  catalogues 
et/ou de spectres.  Le bouton 
« Liste détaillée », vous permet 
de  peaufiner  votre  choix  en 
sélectionnant  ou 
désélectionnant 
individuellement les serveurs. 
Le résultat est rassemblé sous la forme d’un arbre de données.

« FOV » - Les champs instrumentaux

 Ce  formulaire  permet  d’accéder  à  une  liste  de  description  de  champs  de  vue 
instrumentaux (« FoV ») d’un grand nombre de télescopes. Ces champs vont pouvoir 
être superposés aux images pour, par exemple, préparer une mission d’observation.  Ils 
pourront  être  éventuellement  déplacés,  voire  tournés  au  moyen d’une  sélection  à  la 
souris.
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Il est possible de définir ses propres champs instrumentaux sous la forme d’un fichier 
XML.  Vous  trouverez  la  description  de  la  syntaxe  et  quelques  exemples  à  l’adresse 
suivante : http://aladin.u-strasbg.fr/java/FAQ.htx#FoV.

« SExtractor «  - L’extraction de sources

Ce  formulaire  donne  accès  à  l’outil  « SExtractor »  (Bertin  &  Arnouts,  1996  - 
http://terapix.iap.fr/)  afin  de  générer  un  catalogue  de  sources  à  partir  de  l’image 
courante. Ce formulaire est décrit en détails à la section 6.4.

5.2.7 Particularités du formulaire Aladin

 L’onglet « Aladin images » ouvre le formulaire d’accès aux images stockées 
au CDS (Strasbourg –France) spécialement pour Aladin. Vous y trouverez 
entre autres les images DSS, 2MASS, DENIS, IRAS-IRIS, WENS. Le serveur d’images 
Aladin a la particularité de pouvoir envoyer les images en format JPEG monochrome 
astrométriquement calibrée. Si votre bande passante réseau est faible c’est le serveur 
d’images le plus pratique. Autre particularité, lorsque la liste des images disponibles se 
présente sous la forme d’une table il est possible de trier les images en cliquant sur les 
en-têtes de cette table.

5.2.8 Particularités des formulaires VizieR

Le serveur VizieR offre un accès à la quasi-totalité des catalogues astronomiques 
(plusieurs milliers). Il peut s’agir de simples tables publiées dans la littérature 
scientifique ou de catalogues issus de très grands relevés dont certains comptent 
plusieurs  milliards  d’objets.  Il  peut  également  s’agir  de  logs  de  missions,  à  savoir 
d’historiques de pointages des grands télescopes. Afin de simplifier l’usage de Vizier, 
Aladin dispose de 3 formulaires :
 « All Vizier » : formulaire générique pour accéder à n’importe quel catalogue ;
 «  Surveys » : formulaire dédié aux grands relevés ;
 « Missions » : formulaire dédié aux listes d’observations.
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All Vizier – Tous les catalogues de Vizier

Le formulaire général (« All VizieR ») permet soit de renseigner directement le nom ou le 
numéro du catalogue (nomenclature CDS/ADC) dans le champ prévu à cet effet, soit 
d’obtenir une liste de catalogues répondant à certains critères (textes libres, auteurs… ou 
longueur d’ondes, nom de mission ou mots clés astronomiques). Cette recherche peut 
être  restreinte  à  un  cône  s’il  est  spécifié  dans  les  champs  « Position/Rayon ».  Cette 
fonction est extrêmement utile pour déterminer tous les catalogues ayant au moins une 
observation dans le champ. Vous devez ensuite cocher dans la liste le ou les catalogues 
dont vous souhaitez récupérer les sources, puis cliquer sur le bouton « SUBMIT ».

Astuce : Un clic produit un plan catalogue. Il peut être judicieux de « distribuer » vos 
résultats dans plusieurs plans pour pouvoir plus facilement les manipuler par la suite.
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« Surveys » et « Missions »

Les deux autres formulaires dédiés à VizieR regroupent par commodité d’une part tous 
les grands « relevés » et d’autre part toutes les « listes d’observations » disponibles dans 
VizieR. Ces catalogues particuliers sont présentés sous la forme de liste cliquable.

« Toute colonne » et « catalogue complet »

Certains formulaires dédiées à VizieR disposent de deux sélecteurs, l'un pour récupérer 
toutes les colonnes des catalogues demandés – et non uniquement celles fournies par 
défaut par VizieR, l'autre pour récupérer la totalité des catalogues demandés, sans tenir 
compte d'une position particulière. Cette dernière option est limitée au premier million 
de sources.

5.2.9 Particularités du formulaire SkyBot

L’onglet  « SkyBot »  ouvre  un  formulaire  d’accès  aux  objets  du  système 
solaire (hors planètes). L’institut de mécanique céleste de Paris (IMCCE) met 
à disposition d’Aladin sa base de données des éphémérides ce qui permet de trouver 
avec une excellente précision les astéroïdes et autres objets du système solaire présents 
sur votre image en fonction de l’époque de celle-ci. 
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Le champ pour indiquer la date est automatiquement renseigné en fonction de l’époque 
de l’image courante.

A noter : l’époque indiquée dans l’en-tête de l’image n’est pas toujours très précises d’où 
de  possibles  erreurs  de  positionnements.  Dans  ce  cas,  il  vous  sera  nécessaire  de 
renseigner manuellement cette date.

D’autre part, il est possible de saisir dans le champ position le nom d’un astéroïde ou 
d’une comète afin que SkyBot le remplace par sa position céleste à la date mentionnée. 
Pour  cela  il  est  nécessaire  de  presser  le  bouton  « Obtenir  les  coord.  Pour  cet  
objet+époque ».

5.2.10 Ajout d’un serveur personnel

La fenêtre du « sélecteur de serveurs » peut être adaptée à vos propres serveurs. Il est 
ainsi possible de définir un serveur personnel qui ajoutera un onglet/formulaire. Pour ce 
faire, il est nécessaire de créer un petit fichier donnant les informations tels que le nom, 
la  description,  l’adresse  Web,  divers  paramètres,  puis  de  redémarrer  Aladin  en 
indiquant sur la ligne de commande le nom de ce fichier :

java –jar Aladin.jar –glufile=votreFichier

Exemple de fichier de description:  
%ActionName MonServeur
%Aladin.Label Test
%Description Ceci est un exemple de serveur
%URL  http://mon.site.web/ma/base/requete?yy=$1&xx=$2
%Param.Description $1=Paramètre 1
%Param.Description $2=Paramètre 2
%ResultDataType Mime(image/fits)

La  syntaxe  complète  est  décrite  dans  la  FAQ  d’Aladin  (http://aladin.u-
strasbg.fr/java/FAQ.html#Glu). 
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Après  avoir  détaillé  les  2  fenêtres  principales  d’Aladin,  nous  allons  présenter  les 
différentes fenêtres annexes.

5.3 Le gestionnaire de la dynamique des pixels 

Bouton pixel 
Menu : Image => Constraste des pixels 
Raccourci : Ctrl+M

Aladin  implémente  un  algorithme  pour  rendre  au  mieux  le  contraste  des  images 
astronomiques.  Celles-ci  se  caractérisent  par  une  dynamique  de  valeurs  de  pixels 
souvent très large, et avec parfois des valeurs aberrantes (bord du détecteur, saturation, 
valeurs inconnues…). Or le rendu visuel « monochrome » (ou en fausses couleurs)  ne 
peut prendre que 256 valeurs sur les matériels informatiques actuels. Par conséquent 
Aladin effectue un échantillonnage des pixels afin d’appliquer un seuillage : toutes les 
valeurs de pixels inférieures au seuil bas seront affichées en blanc, celles au-dessus du 
seuil  haut  en  noir,  et  les  valeurs  intermédiaires  seront  converties  entre  0  et  255 
linéairement.  Le  « seuillage 
automatique »  d’Aladin  donne  la 
plupart  du  temps  un  bon  contraste 
sur les pixels « intéressants ». 

Les 256 valeurs de pixels peuvent être 
affichées  soit  en  niveau  de  gris,  en 
positif  ou  en  négatif,  soit  avec  une 
table  de  couleurs  faisant 
correspondre à chaque valeur de pixel 
une couleur particulière. 

Il  est  cependant  possible  que  les 
pixels  « intéressants »  ne  soient  pas 
ceux qui vous intéressent,  ou encore 
que  l’algorithme  de  seuillage 
automatique ne soit pas bien adapté 
aux  caractéristiques  des  images  que 
vous  visualisez.  Pour  ajuster 
manuellement  la  dynamique  des 
pixels, vous utiliserez le menu « Image 
=> Contraste  des  pixels », ou  plus 
directement  le  bouton  « pixel » 
accessible dans la barre d’outils.

La fenêtre de la dynamique des pixels 
présente :
 un bandeau visualisant le rendu des 256 niveaux de pixels ;
 un histogramme de la répartition des pixels  entre la plus petite  valeur et  la  plus 

grande valeur retenues par Aladin ;
 trois curseurs de réglage ;
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 et un bandeau d’information et de contrôle.

En un clic !

Si  vous  désirez  seulement  augmenter  ou  diminuer  le  contraste  d’une  image  sans 
modifier  la  plage  des  pixels  retenue,  il  suffit  de  modifier  le  choix  de  la  fonction  de 
transfert :
 Log : très contrasté
 Sqrt : contrasté
 Linear : normal
 Pow2 : peu contrasté

Si  vous  désirez  régler  finement  la  dynamique  des  pixels,  il  est  nécessaire  de  lire  et 
comprendre ce qui suit.

Informations sur les pixels

En bas  de  la  fenêtre,  vous  trouvez les  informations  indiquant  la  valeur  minimale  et 
maximale  présentes  dans  l’image,  ainsi  que  le  seuil  bas  et  le  seuil  haut  déterminés 
automatiquement par Aladin (« seuils limites »). 

La courbe affichée en surimpression sur l’histogramme trace la fonction de transfert 
utilisée pour faire correspondre les valeurs pixels retenues et les 256 niveaux possibles. 
Par défaut, il s’agit d’un droite oblique car par défaut d’une part la conversion est une 
simple translation linéaire,  et d’autre part la table des couleurs utilisée est « gray » - 
niveaux de gris,  ce qui  signifie  que les  3 composantes  Rouge-Vert-Bleu des couleurs 
effectivement  affichées  ont  toujours  des  valeurs  identiques.  Une  table  des  couleurs 
utilisant autre chose que du gris fera apparaître 3 courbes distinctes, l’une pour le rouge, 
l’autre pour le vert et la dernière pour le bleu. Lorsque vous déplacez le pointeur de la 
souris sur l’histogramme, la valeur du pixel s’affiche en abscisse, et la correspondance en 
rouge, en vert et en bleu en ordonnée sur la droite de l’histogramme. Simultanément, la 
couleur finale obtenue est encadrée dans le bandeau supérieur.

Fonctions de transfert

Par  défaut,  Aladin  utilise  donc  une  fonction  linéaire  pour  établir  la  correspondance 
valeur du pixel => entrée dans la table des couleurs.  Les 3 curseurs sous l’histogramme 
permettent  de  changer  la  pente  de  cette  fonction,  voire  d’utiliser  deux pentes,  l’une 
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correspondant au 128 valeurs basses dans la table des couleurs, l’autre au 128 valeurs 
hautes.
Concrètement  le  déplacement  des  curseurs  de 
droite et de gauche réajuste les seuils haut et bas 
et le curseur central tiré vers la gauche augmente 
le contraste, vers la droite le diminue. 
Si la touche  Ctrl (resp. « Pomme » pour Mac)   est 
appuyée,  le  curseur  central  se  transforme  en 
losange  et  devient  également  sensible  aux 
déplacements verticaux de la souris. Ceci a pour 
effet  de  réduire  ou  augmenter  simultanément 
l’intervalle  avec  les  curseurs  de  droite  et  de 
gauche. C’est une méthode qui permet d’ajuster rapidement la dynamique maximale sur 
la zone de pixels à mettre en évidence.

Le bandeau de contrôle permet également de choisir d’autres fonctions non linéaire : 
log, sqrt, pow2. Comme indiqué précédemment, le log donnera une image très contrastée, 
le sqrt une image contrastée, et le pow2 faiblement contrastée.

Tables des couleurs

Aladin  dispose  de  quelques  tables  de  couleurs  classiques  en  astronomie.  Celles-ci 
peuvent être non seulement ajustées via le contrôle de la fonction de transfert comme 
indiqué précédemment, mais également inversées 

Voici la liste des tables des couleurs avec une fonction de transfert linéaire simple et leur 
rendu en mode normal et en mode inversé :

 Gray:

 BB:

 A:

 Stern :

 Rainbow :

 Eosb :
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 Fire :

A noter : Les utilisateurs d’IDL peuvent également charger dynamiquement une table 
des couleurs IDL via la librairie IDL-Aladin (cf. 7.4).

Exploration rapide des pixels

En survolant le barre de la table des couleur – en haut de la fenêtre -  avec le pointeur de 
la souris, Aladin va utiliser temporairement une table des couleurs particulières afin de 
mettre en évidence les positions des pixels correspondants dans l’image. L’image sera 
affichée en niveau de gris, et les pixels concernés en rouge. 

Modification des seuils initiaux

Comme indiqué en introduction, à chaque chargement d’une image, Aladin procède à 
une seuillage automatique. Il est cependant possible de modifier les seuils haut et bas 
initiaux en les spécifiant explicitement dans le bandeau de contrôle. Si vous cochez la 
case « utiliser le seuillage automatique », Aladin appliquera à nouveau son algorithme de 
seuillage  en  ne  cherchant  les  pixels  significatifs  qu’entre  les  bornes  que  vous  avez 
indiquées. Si la coche n’est pas activée, les seuils haut et bas seront pris tels que vous les 
avez spécifiés.  Le bouton  « Récupérer tout » est un raccourci  pour prendre en compte 
toute la dynamique de l’image.

La procédure de modification des seuils initiaux nécessite un traitement un peu plus 
long  (quelques  secondes,  proportionnel  à  la  taille  de  l’image),  alors  que  le  simple 
ajustement de contraste par modification de la fonction de transfert est quasi immédiat.

Images particulières, cas particuliers

Lorsqu’il  s’agit  d’une image en vraies couleurs,  ou d’un cube d’images, la  fenêtre est 
adaptée en fonction de la nature de données.

Image couleur  
Aladin peut manipuler des images en « vraies » couleurs (composition colorées – cf. 5.9, 
images  JPEG,  GIF,  PNG ou  FITS couleur).  Dans  ce  cas,  il  n’y  a  pas  de  seuillage 

50



automatique et la fenêtre de contrôle de la dynamique fait apparaître 3 histogrammes les 
uns  au-dessus  des  autres,  munis  de  leurs  curseurs  de  contrôle,  correspondants  à  la 
répartition des valeurs de pixels dans les 3 composantes Rouge, Vert et Bleu. Chaque 
histogramme est muni de ses 3 curseurs de contrôles comme pour une image classique. 
Le maintien appuyé de la touche Maj lors du déplacement d’un curseur synchronise les 
curseurs  des  2  autres  composantes  couleurs  permettant  d’effectuer  un  ajustement 
simultanément sur les 3 composantes. 

Cubes d’images  
Aladin peut manipuler des cubes d’images (cf.  5.10 - associations d’images, ou cubes 
FITS).  Dans ce cas l’histogramme de la répartition des pixels ne concerne que l’image en 
cours  d’affichage.  Si  le  cube  est  en  cours  de  défilement,  l’histogramme  évoluera 
dynamiquement en fonction de l’image courante. Toutes les possibilités d’ajustement de 
la dynamique des pixels sont les mêmes que pour une image simple. Dans le cas de très 
gros  cubes  (plusieurs  centaines  de  mégaoctets),  les  opérations  de  modifications  du 
seuillage d’origine peuvent nécessiter quelques secondes pour que le résultat soit visible 
sur l’ensemble des images composant le cube.

Réglage du contraste directement dans la vue

Pour un simple ajustement du contraste, il est également possible le bouton droit de la 
souris  directement  dans  la  vue  de  l'image.  Un  déplacement 
vertical modifie le constraste, un déplacement vertical modifie 
les seuils. Lors de cette opération, la table des couleurs utilisée 
apparaît en haut de l'image.
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5.4 Générateur de contours

Bouton cont 
Menu : Graphique  => 
Tracer des contours… 

Aladin  dispose  d’un  outil  d’extraction  de 
contours permettant de générer des isophotes 
d’une image. Le menu « Graphique => Tracer  
des contours… » ouvre une fenêtre de contrôle 
vous  permettant  d’ajuster  le  nombre 
d’isophotes souhaité ainsi que leur niveau de 
pixel  en  regard  de  l’histogramme  de 
distributions  des  pixels  présents  dans 
l’image.  Il  est  possible  d’effectuer  des 
lissages,  ou  de  réduire  le  bruit  de  l’image 
avant l’extraction des contours, ou encore de 
réduire  l’extraction  à  la  portion  de  l’image 
visible  dans  la  vue.  Ce  dernier  paramètre 
permet de réduire le temps de calcul pour les 
très grosses images.

Les contours vont être mémorisés dans un 
plan de la pile, superposable à l’image 
d’origine, mais également à d’autres image 
(mémorisation des coordonnées célestes). 
Cette propriété permet de comparer aisément deux images n’ayant, par exemple, pas la 
même longueur d’ondes.

Astuce : La fenêtre des propriétés associées à un plan contour (menu : Edition => 
Propriétés) permet d’ajuster a posteriori les niveaux et la couleur de chaque contour

5.5 Gestionnaire des filtres de catalogues

Bouton filtre 
Menu : Catalogue => Créer un nouveau filtre… 
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Le  filtrage  des  catalogues  dans  Aladin  est  un  outil  puissant  pour  visualiser 
« intelligemment » les sources.

Comportement par défaut (sans filtre)

Aladin  représente,  par  défaut,   les  sources  à  l’aide  de  symboles  graphiques,  tous 
identiques pour un plan catalogue donné (couleur et forme). La forme est uniquement 
fonction du nombre de sources (plus petits symboles pour les catalogues denses).  La 
couleur  et  la  forme  peuvent  être  modifiées  a  posteriori  en  utilisant  les  propriétés 
attachées au plan catalogue (menu « Edition => Propriétés »).

Il peut être cependant intéressant de contraindre la forme et la couleur en se basant sur 
les valeurs des mesures associées à chaque source. Pour cela il est nécessaire d’utiliser ce 
qu’Aladin nomme « un filtre ».

Définition du filtre

Pour  Aladin,  un  filtre  va  être 
appliqué  à  un  ou  plusieurs  plans 
catalogues  afin  de  modifier  la 
manière  dont  les  symboles 
graphiques  sont  tracés  dans  la  vue. 
Il s’agit d’une ou plusieurs règles qui 
indiqueront  à  Aladin  comment 
dessiner les sources en fonction des 
valeurs  présentes  dans  les  mesures 
de chaque source. Ainsi il sera ainsi 
possible  de  tracer  des  cercles 
proportionnels  à  la  magnitude,  des 
ellipses d’erreur sur la position, des 
flèches dont l’orientation et la taille 
dépendent  des  valeurs  de 
mouvements propres… 

Représentation du filtre dans la pile  
Schématiquement,  le  filtre  est  représenté  comme  un  plan  spécial  dans  la  pile  qui 
s’applique à tous les plans catalogues situés en dessous de lui.

Utilisation d’un filtre prédéfini

Aladin propose quelques filtres prédéfinis qui correspondent aux manipulations les plus 
courantes  en  astronomie.  Vous  pouvez  ainsi  les  sélectionner  et  les  appliquer 
immédiatement via le menu « Catalogue => Filtres prédéfinis ».
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En revanche, il est souvent nécessaire d’ajuster plus finement les contraintes du filtres et 
pour cela de créer ou d’éditer manuellement vos règles de filtrage. C’est ce qui va être 
détaillé dans la section suivante.

Génération  d’un 
filtre

Un  filtre  est  généré  au 
moyen  du  bouton 
« filtre » présent dans la 
barre d’outils ou à partir 
du menu « Catalogue => 
Créer un nouveau filtre ». 
Deux  modes  sont 
exploitables  via  des 
onglets :
 Le mode « débutant » 

qui revient à utiliser 
un  filtre  prédéfini 
(voir ci-dessus) ;

 Le  mode  « expert » 
où vous êtes chargés 
d’éditer vous-mêmes 
vos règles de filtrage.

Le  panneau  du  mode 
expert  vous  permet 
d’éditer  les  règles  du 
filtre  dans  la  boite 
d’édition centrale, et vous propose toute une série d’aides à la rédaction :
 De nombreux exemples commentés qui peuvent servir de base à vos propres filtres ;
 Des boutons d’accès aux références des colonnes des catalogues actuellement chargés 

dans Aladin ;
 Un bouton d’accès aux « actions » graphiques à mettre en œuvre ;
 Des  boutons  d’accès  aux  fonctions  mathématiques  et  aux  unités  physiques 

disponibles.
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Il vous est également possible de recharger un filtre  depuis un fichier préalablement 
sauvegardé.

Syntaxe

Pour comprendre la syntaxe d’un filtre,  partons de l’exemple suivant. Supposons que 
vous vouliez afficher les « types d’objets », et uniquement pour les sources brillantes. Ce 
filtre pourra s’écrire de la façon suivante :

${B}<18 { draw ${OTYPE}   }
Seules les lignes dont la valeur dans la colonne « B » (magnitude B) est inférieure à 18 
seront retenues, et l’affichage portera sur le contenu de la colonne « OTYPE » (type 
d’objet).

Comme nous le voyons, un filtre de base suit la syntaxe suivante : 
un_test { une_action }

 Le test est facultatif et s’il n’y en a pas toutes les sources sont concernées ;
 Il est possible d’indiquer plusieurs actions, séparées par le caractère ‘ ;’ ou un retour 

à la ligne ;
 Il  est  possible d’avoir  plusieurs groupes « test{action} » consécutifs,   sachant  que 

c’est l’action associée au premier test « vrai » de la liste qui sera prise en compte, les 
autres lignes étant ignorées.

${class}="Star" {draw square}
${class}="Radio" {draw rhomb}
${class}="Galaxy" {draw plus}

 Les lignes commençant par ‘#’ sont des commentaires.

Le test
 Le test utilise les habituels opérateurs de comparaison (=, !=, <, >, >=, <=).
 Il peut comporter des parenthèses et des opérations booléennes ET (&&), OU (||), 

NON ( !)
 Il peut utiliser des fonctions mathématiques (abs, cos, deg2rad, exp, ln, log, rad2deg, 

sin, sqrt, tan) ;

Exemple :  Tracé des sources répondant à l’expression suivante :
log( abs(${Fi})/${Fx} ) > 44 { draw }
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 Il est nécessaire d’utiliser des guillemets (") pour les chaînes de caractères. Les jokers 
‘ ?’ et ‘*’ y sont autorisés ;

 L’opérateur « undefined(…) »  permet de repérer les lignes n’ayant pas de valeur pour 
une colonne donnée.

Les actions graphiques
Deux actions sont possibles :
 draw : pour afficher une source ;
 hide : rarement utilisée, elle permet de cacher des sources particulières.

Dans le cas d’un « draw »,  l’action peut porter sur la  forme et/ou sur la  couleur du 
tracé. La syntaxe est la suivante :

draw couleur forme
Le  panneau  d’édition  du  filtre  propose  deux  boutons  permettant  de  sélectionner 
rapidement la forme et/ou la couleur désirée.

Les fonctions de formes et  de couleurs peuvent faire référence  à des colonnes et/ou 
utiliser des expressions arithmétiques.

Exemple :  Tracé de triangles rouge : 
{ draw red triangle }
Exemple :  Tracé d’ellipses

{ draw ELLIPSE(0.5*${MajAxis},0.5*${MinAxis},$
{PosAng}) }

Exemple :  Tracé de carrés dont la couleur dépend de la magnitude
{ draw RAINBOW(${magB}) square }
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Les fonctions particulières
 FILLCIRCLE : cercle plein ;
 FIXEDCIRCLE : Cercle dont la taille est fixe (non assujettie à la valeur du zoom de la 

vue) ;
 PM :  flèche dont l’orientation et la taille dépendent des deux angles indiquant un 

mouvement propre ;
 LINE : tracé d’un segment, très utile pour visualiser les résultats d’une corrélation 

entre 2 catalogues.

Les fonctions CIRCLE, FILLCIRCLE et RAINBOW acceptent deux paramètres facultatifs 
fournissant les valeurs minimale et maximale utilisées pour le traçage. Exemple : draw 
CIRCLE(${A},1,10) tracera des cercles proportionnels pour les valeurs de la colonne 
« A », le plus petit cercle ayant 1 pixel de rayon, le plus grand cercle 10 pixels (en zoom 
1x).

Si l’action « draw » porte sur une chaîne (ex : draw "étoile") ou une référence à une 
colonne (ex : draw ${ObjectClass}), ce sera la chaîne ou la valeur de la colonne qui 
sera affichée.

Nom de colonne ou UCD  
La référence à une valeur de colonne se fait classiquement par le nom de la colonne via 
la syntaxe  ${NOM_DE_COLONNE}.  Cette méthode implique que le filtre soit plus 
ou  moins  dédié  à  un  catalogue  particulier  puisqu’il  est  nécessaire  de  connaître 
explicitement les noms des colonnes. Pour écrire des filtres plus génériques, par exemple 
prenant en compte la magnitude quelque soit le nom de colonne que l’auteur a donné, 
Aladin utilise les UCD.

Les  UCDs,  ou  « Unified  Content  Descriptors »  fournissent  une  caractérisation  des 
colonnes  indépendante  du catalogue.  A chaque  colonne a  été  associée  une UCD qui 
permet de connaître la grandeur physique représentée par la colonne. Par exemple une 
colonne avec des magnitudes sera étiquetée par l’UCD « pos.mag ». La liste des UCDs 
est  maintenue  par  un  comité  international  et  disponible  à  l’adresse 
suivante : http://www.ivoa.net/Documents/latest/UCDlistMaintenance.html .  La 
plupart des serveurs en astronomie fournissent leurs catalogues en VOTable déjà munis 
de ces précieuses UCDs.

Lorsqu’une règle de filtre utilise une UCD, la syntaxe utilisée est $[UCD]. Les jokers ‘*’ 
et ‘ ?’ sont autorisés. Par exemple $[phot*] correspond à la première colonne ayant une 
UCD  qui  commence  par  « phot »,  donc  la  première  colonne  ayant  des  mesures  de 
magnitude.

En  résumé,  la  référence  à  une  colonne  par  son  nom  s’écrit  avec  des  accolades,  la 
référence à une colonne par son UCD avec des crochets.

Exemple :  Tracé d’un cercle proportionnel à la magnitude pour toutes les 
sources plus brillante que 12

$[phot*]<12 { draw circle(-$[phot*]) }
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Pour simplifier la saisie des références aux colonnes, le panneau d’édition d’un filtre 
propose deux boutons « Colonnes » et « UCDs » qui permettent de cliquer dans une liste 
sur  le  nom  de  colonne,  respectivement  sur  l’UCD,  afin  que  le  texte  correspondant 
s’écrive automatiquement à l’emplacement du curseur dans la fenêtre d’édition.

Dans le cas où des sources sont sélectionnées dans la vue, et font donc apparaître leurs 
mesures, il est possible de désigner une colonne en cliquant simplement dessus dans le 
panneau des mesures. Pour cela, il est nécessaire de choisir le sous-menu « Pointer… » 
lorsque vous cliquez dans « Colonnes » ou « UCDs ».

Unités physiques  
L’indication d’unités physiques (ex : arcmin, Jy…) dans le test permet de s’affranchir de 
la conversion manuelle pour des expressions utilisant des colonnes dont les valeurs ne 
sont  pas  exprimées  dans  la  même unité.  Les  unités  peuvent  être  composées  comme 
montré dans l’exemple ci-dessous. C’est une fonction puissante qui permet d’écrire des 
filtres très génériques.

Exemple :  Tracé d’un cercle proportionnel au flux en X (UCD : 
phot.flux;em.X-ray) pour toutes les sources dont le niveau d’énergie est 

supérieur au seuil mentionné
$[phot.flux;em.X-ray]>10^-8 erg/m^2/s
{ draw circle($[phot.flux;em.X-ray]) }

Modification d’un filtre

Pour retrouver la fenêtre d’édition d’un filtre, il faut sélectionner le filtre en question 
dans la pile, puis afficher ses propriétés via le menu « Edition  => Propriétés ».
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Etendue d’application d’un filtre

Pour s’appliquer un filtre doit être activé via la coche présente juste 
devant son logo dans la pile. Par défaut, un filtre s’applique à tous 
les plans catalogues qui se situent en dessous de lui dans la pile 
Aladin. En revanche, si un filtre est placé dans un dossier de la pile, 
il ne s’appliquera qu’aux plans catalogues présents dans ce même dossier.

Filtre dédié à un plan catalogue unique

Certains serveurs proposent une série de filtres dédiés à leurs données (Simbad, NED, 
Skybot…).  Ils  apparaissent  dans  le  formulaire  d’interrogation  des  données  (cf.  5.2 
Sélecteur  de  Serveurs)  sous  la  forme  d’une  liste  déroulante  à  la  fin  de  la  liste  des 
paramètres d’interrogation.

Un filtre « dédié », s’il est activé n’apparaît pas dans la pile et il s’applique uniquement 
au plan catalogue en question. Il inhibe l’action de tout autre filtre générique sur ce plan. 
Le  choix  ou  l’activation  d’un  filtre  « dédié »  peut  être  modifié  a  posteriori  via  les 
« propriétés » associées au plan (menu Edition => Propriétés…). Via le bouton « This filter  
on the stack for edition », il est également possible de « transformer » un filtre « dédié » 
en filtre générique pour le modifier et/ou de l’appliquer à plusieurs plans catalogues.

Exemples de filtres génériques

Cercles en fonction 
de la magnitude

{
   draw circle(-$[phot.mag*])
}
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Ellipses de 
position
+
Affichage par 
défaut

{
  draw ellipse(
   0.5*$[phys.angSize.smajAxis], 
   0.5*$[phys.angSize.sminAxis], 
   $[pos.posAng])
   draw
}

Carrés bleu pour 
les sources 
brillantes

$[phot.mag*]<17 {
   draw blue square
}

Différents 
symboles colorisés 
en fonction de la 
classe de l’objet

$[src.class]="Star"
   {draw red square}
$[src.class]="Radio"
   {draw blue rhomb}
$[src.class]="Galaxy"
   || $[src.class]="Seyfert"
   {draw green plus}

Mouvements 
propres

{
   draw pm(
      5*$[pos.pm;pos.eq.ra], 
      5*$[pos.pm;pos.eq.dec])
}

 

5.6 Corrélateur de catalogues

Bouton corr. 
Menu : Catalogue => Corréler les catalogues sélectionnés… 

Aladin intègre  un outil  de corrélation de sources.  Il  s’agit  de déterminer  les  sources 
communes à deux catalogues. Le corrélateur va considérer 2 plans catalogues, opérer la 
corrélation et générer un nouveau plan catalogue contenant les objets communs.

La fenêtre qui contrôle la corrélation est accessible par le bouton « corr. » ou le menu 
« Catalogue => Corréler les catalogues sélectionnée ».

Les 3 modes de corrélations

Aladin propose 3 modes de corrélations accessibles par les onglets en haut de la fenêtre 
de corrélation :
 Une corrélation basée uniquement sur la position ;
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 Une corrélation « par champ » basée sur la présence de valeurs identiques dans une 
colonne de chaque catalogue (typiquement un identificateur) ;

 Une corrélation basée sur la position avec prise en compte d’ellipses d’erreur.

Corrélation par position
Le  panneau  du  corrélateur 
positionnel permet d’indiquer les 2 
catalogues  concernés  ainsi  que  les 
colonnes  correspondantes  à  la 
position  (ra,dec).  S’il  n’y  a  pas 
d’ambiguïté, les noms des colonnes 
ont  déjà  été  correctement 
renseignés par Aladin. Il est ensuite 
nécessaire  d’indiquer  la  limite  de 
séparation  supérieure,  voire 
inférieure, pour laquelle les sources 
seront  corrélées.  Elle  est  exprimée 
en  secondes  d’arc.  Enfin  un 
sélecteur offre 3 choix :

1. Lorsqu’il y a plusieurs objets 
dans le cercle de corrélation, 
seule la source la plus proche 
sera corrélée ;

2. Ou au contraire, toutes les combinaisons seront conservées ;
3. Ou encore, seules les sources n’ayant pas de contreparties seront retenues.

Corrélation par champ
La corrélation par champ consiste à réunir les sources dont une valeur de champ est 
présente à l’identique dans les deux catalogues. Ce type de corrélation est dédié à un 
champ qui identifie de manière unique chaque source, par exemple un identificateur, un 
numéro de série… En base de données, on parlera de « jointure ».

Corrélation par ellipses
Le panneau pour contrôler la corrélation par ellipses est similaire à celui de la simple 
corrélation  par  position.  La  différence  notable  est  la  possibilité  de  spécifier  non 
seulement les colonnes de position mais également celles qui donnent l’erreur sur la 
position.  Cette  erreur  doit  être  exprimée  sous  la  forme de  3  champs  décrivant  une 
ellipse : l’axe majeur, l’axe mineur et l’orientation par rapport au nord.

Choix des champs à conserver

Lorsque  Aladin  effectue  une  corrélation,  il  crée  un  nouveau  plan  catalogue  avec  les 
résultats. Chaque paire de sources corrélées va correspondre à une source dans la plan 
résultat, et par défaut, toutes les mesures des deux sources vont être conservées. Pour 
éviter des confusions possibles sur les noms de colonnes, ils seront automatiquement 
suffixés par « _tab1 », respectivement « _tab2 ».
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En  utilisant  le  bouton  « Advanced  options » présent  dans  chacun  des  formulaires  de 
corrélation, il est possible de choisir explicitement les colonnes à conserver ainsi que de 
préciser les suffixes ou éventuellement les préfixes de noms de colonnes.

Colonnes et UCDs  
Lorsque le pointeur de la souris survole les boutons pour sélectionner les colonnes, les 
boutons en correspondance dans les deux catalogues vont s’afficher sur fond bleu. Cette 
correspondance s’appuie sur des UCD communes pour ces deux colonnes (une UCD est 
un attribut  propre  à  chaque  colonne qui  caractérise  sa  signification  physique  – ex : 
« pos.eq.dec » pour une mesure de déclinaison - Cf. description des UCD dans la section 
5.5).
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A  noter : Certains  UCD  ne  doivent  apparaître  qu’une  seule  fois  dans  une  table 
(« meta_main »). Ainsi, si la correspondance s’affiche sur fond rouge, cela signifie qu’il 
va y avoir conflit d’UCD. Pour lever le conflit, il est nécessaire de cliquer sur le nom de la 
colonne prépondérante en maintenant la touche Ctrl enfoncée. A l’absence d’indication, 
ce sera la colonne du premier catalogue qui sera prépondérante.

5.7 Calculateur de colonnes
Menu : Catalogue => Ajouter une nouvelle colonne…

Les catalogues fournissent un certain nombre de mesures qu’il est possible de visualiser 
dans le  « panneau des  mesures » en sélectionnant  les  sources concernées (cf.  5.1.6 les 
mesures).  Ces mesures se présentent sous la forme de plusieurs colonnes de valeurs. 
Aladin offre la possibilité  d’ajouter des colonnes qui sont obtenues par calcul  sur les 
valeurs  d’autres  colonnes.  Par  exemple  il  est  possible  de  créer  une  colonne  « J-K » 
fournissant la différence entre deux colonnes de magnitude « J » et « K ».

Accès à la fenêtre

La fenêtre pour gérer le calcul  d’une 
nouvelle  colonne  s’ouvre  soit  par  le 
menu  contextuel  du  « panneau  des 
mesures «  (clic  droit  ou  CTRL  clic), 
soit via le menu principal « Catalogue 
=> ajouter  une  nouvelle  colonne… ». 
Dans  ce  dernier  cas,  il  aura  fallu 
spécifier  au  préalable  le  catalogue 
concerné  en  sélectionnant  son  plan 
dans la pile.

Information  générale  sur  la 
nouvelle colonne

La  création  d’une  nouvelle  colonne 
nécessite  la  spécification  d’un  nom. 
De  manière  facultative  vous  pouvez 
indiquer l’unité de la nouvelle colonne 
ainsi  que  l’UCD  qui  doit  y  être 
associée (cf. 5.5 utilisation des filtres). 
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Vous pouvez également spécifier le nombre de décimales significatives lors de l’affichage 
des valeurs.

Expression de calcul

Pour  créer  une  nouvelle  colonne,  il  est  nécessaire  d’indiquer  l’expression  de  calcul 
qu’Aladin doit utiliser pour générer les valeurs de cette nouvelle colonne. La saisie se fait 
dans le cadre central intitulé « Expression ». La syntaxe utilisée reprend les conventions 
habituelles d’une expression algébrique. Les références aux autres colonnes respectent la 
syntaxe :

${nom_de_colonne}
Pour éviter les erreurs de saisie, la fenêtre affiche une liste de boutons reprenant les 
noms  des  colonnes  du  catalogue  concerné.  Un  clic  souris  sur  l’un  d’eux  insère,  à 
l’emplacement du curseur dans le panneau de saisie de l’expression, la référence à la 
colonne concernée.
Il  est  également  possible  d’insérer  les  opérateurs  (+,  -,  *,  /…)  et  les  fonctions 
mathématiques éventuellement nécessaires (abs, cos, sin, rad2deg, …) en cliquant sur 
les boutons et sélecteurs correspondants. 

Génération de la colonne

Une  fois  créée  en  utilisant  le  bouton  « Crée  la  colonne »,  les  nouvelles  valeurs 
apparaîtront tout à droite de la table des mesures, et en couleur brun/orangé afin de les 
distinguer facilement des mesures originales. Cette nouvelle colonne peut être utilisée 
comme toutes les autres colonnes : triée, filtrée... Elle sera sauvegardée avec les autres 
colonnes le cas échéant.

5.8 Fenêtre de calibration astrométrique
Menu : Image => Calibration astrométrique…

Catalogue => Calibration astrométrique …

Lorsque Aladin superpose des sources sur une image, il utilise la solution astrométrique 
associée  à  cette  image.  Il  s’agit  d’informations  permettant  de  faire  correspondre  à 
chaque  pixel  de  l’image  une  position  dans  le  ciel  et  réciproquement.  Il  existe  de 
nombreuses possibilités qui décrivent généralement une méthode de projection d’une 
portion de la sphère céleste sur une plan (tangentielle, sinusoïdale, …). Aladin gère les 
projections  couramment  utilisées  en  astronomie  (SINUS,  TANGENTIAL,  AITOFF, 
ZENITAL_EQUAL_AREA, STEREOGRAPHIC, CARTESIAN,  NCP, ZPN)

Informations de calibration astrométrique

Aladin dispose de 3 méthodes pour connaître la calibration astrométrique d’une 
image :
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 Lorsqu’il s’agit d’image au format FITS, les informations de calibration sont fournies 
via les mots clés adéquats de l’en-tête FITS (selon le standard WCS) ;
 Dans le cas d’une image JPEG, Aladin sait  également reconnaître une calibration 
astrométrique fournie dans son segment commentaire (selon le standard JPEG). Cette 
calibration doit suivre la syntaxe des mots clés  FITS avec un ‘\n’  à la  fin de chaque 
ligne ;
 Enfin, Aladin sait également prendre en compte la calibration astrométrique lorsque 
l’image a été chargée depuis une liste conforme au standard de l’Observatoire Virtuel : 
SIA (Simple Image Access, cf. 8.2 - types de données supportés).

Astuce : Dans les deux premiers cas, l’en-tête FITS peut être visualisée via le menu 
Edition => En-tête FITS.

Une image peut disposer de plusieurs calibrations astrométriques, notamment si vous 
en  avez  générées  manuellement.  Pour  changer  de  solution  astrométrique,  il  est 
nécessaire d’afficher les propriétés du plan et de changer la sélection.

En revanche, si l’image ne dispose pas de calibration astrométrique, Aladin pourra tout 
de même générer des vues mais ne pourra pas superposer de sources ou de surcharges 
graphiques avec des coordonnées célestes. Le déplacement de la souris dans une telle 
image affichera simplement « No astrometrical reduction » dans le cadre de position. Il 
sera  cependant  possible  d’y  ajouter  des  surcharges  graphiques  manuelles  (dessins  à 
main  levée,  marques…),  contours…  Ces  surcharges  graphiques  n’auront  que  des 
coordonnées en XY propres à l’image.

Création/modification d’une calibration astrométrique

Aladin permet de créer manuellement une solution astrométrique pour une image qui 
n’en  dispose  pas,  ou  d’affiner  une  solution  existante.  Pour  cela  il  est  nécessaire  de 
sélectionner le plan image concerné dans la pile (clic sur le nom) puis d’utiliser le menu 
« Image => Calibration astrométrique… ». 

La  fenêtre  de  calibration  vous  demande  en  premier  lieu  de  nommer  votre  nouvelle 
calibration.

Puis, elle propose 3 méthodes pour créer/modifier une calibration :
 Par paramètres ;
 Par correspondances d’étoiles ;
 Par en-tête WCS.

Calibration par paramètres
Le  premier  panneau  affiche  les 
paramètres  de  base  de  la  solution 
astrométrique,  c’est-à-dire  une  position 
céleste  et  les  coordonnées  du  pixel 
correspondant  dans  l’image,  la  taille 
angulaire  du  pixel,  la  méthode  de 
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projection,  un  angle  de  rotation  par  rapport  au  nord  et  enfin  le  sens  croissant  de 
l’ascension droite.

Calibration par en-tête WCS  
Le 3ème panneau affiche les mots clés FITS 
fournissant  les  paramètres  de  la 
calibration dans le standard WCS. Si vous 
connaissez  ce  standard,  vous  pouvez 
directement  modifier  ces  paramètres.  Il 
est  par  exemple  possible  d’utiliser  la 
solution astrométrique d’une autre image 
en  copiant/collant  ses  paramètres  WCS 
tels quels.

Astuce :  Il  est  également  possible  de 
modifier une valeur d’un mot clé WCS via 
la  commande  script :  set  PlanID 
FITS:keyword=value (cf.  7.1 – Aladin 
par script)

Calibration par correspondances d’étoiles
Le 2ème panneau affiche une table destinée à saisir une liste de coordonnées XY images et 
leur  correspondance  en  position  céleste.  C’est  une  méthode  puissante  et  souple  qui 
permet d’obtenir rapidement d’excellentes calibrations. Nous allons brièvement détailler 
la méthode. Pour plus de détails, veuillez vous référer au tutorial en ligne dédié à cette 
manipulation (http://aladin.u-strasbg.fr/tutorials/aladin.gml).

Supposons que nous ayons chargé une image JPEG non calibrée dans la vue de gauche, 
et une image DSS du même champ avec en superposition un catalogue astrométrique tel 
UCAC2 dans la vue de droite. La méthode pour calibrer l’image JPEG consiste à cliquer 
successivement  sur  une  étoile  de  l’image  non  calibrée,  puis  sur  la  source  UCAC2 
correspondante dans l’image DSS. A chaque clic de la souris, Aladin renseigne la table 
du panneau de calibration.  Quatre correspondances  suffisent généralement à obtenir 
une bonne calibration.
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A noter :  Lorsqu’il est nécessaire de déterminer les coordonnées d’une étoile par « clic 
souris », Aladin utilise en algorithme de centroïde par barycentre. S’il n’est pas possible 
de déterminer le centre (étoile trop large), un message indiquera que la position cliquée 
sera prise telle quelle.

Astuces :
 Il  peut  être  judicieux  d’effectuer  une  « symétrie »  de  l’image  DSS  afin  de  se 

rapprocher de l’orientation de l’image à calibrer (menu Image => Symétrie)
 Il est préférable de n’afficher que les sources brillantes et à faible mouvement propre. 

L’utilisation d’un filtre sur le catalogue facilite grandement le repérage des 
correspondances, par exemple : 
$[pos.pm;pos.eq.dec]<3 mas/yr && $[pos.pm;pos.eq.ra]<3 mas/yr
   && $[phot.mag*]<17  { draw circle(-$[phot.mag*]) }

 Il est possible de ne pas charger de catalogue, les coordonnées célestes seront alors 
celles déduites de la calibration de l’image DSS. La précision de la calibration sera 
moins bonne.

 L’utilisation de la semi transparence (Menu « image => Niveau de transparence ») pour 
visualiser l’image qui vient d’être calibrée sur l’image DSS permet de vérifier d’un 
coup d’œil la qualité de la calibration.
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Faire et défaire
Lors  du  processus  de  création  ou  d’ajustement  d’une  calibration,  il  est  possible  de 
revenir à la solution antérieure en utilisant les boutons « Défaire » et « Faire » en bas de 
la fenêtre. 

Calibration d’un catalogue

Aladin offre également la possibilité de calibrer ou recalibrer un catalogue. Cela revient à 
calculer pour chaque source sa position céleste. Sélectionnez le plan catalogue dans la 
pile puis utilisez le menu « Catalogues => Calibration astrométrique… ». L’interface et les 
méthodes sont les mêmes que pour une image.

Déplacement «     à la souris     »  
Si vous utilisez la méthode de calibration par paramètres (1er panneau), il est possible de 
déplacer directement les sources du catalogue à calibrer dans la vue afin de visualiser 
immédiatement le résultat. Il s’agit de cliquer/déplacer une source de ce catalogue au 
moyen de la souris ; les autres sources suivront. Au fur et à mesure du déplacement les 
paramètres de calibration s’ajustent automatiquement. Le déplacement est validé par le 
bouton  « CREER »  ou  « MODIFIER »  qui  calcule  les  nouvelles  positions  célestes  des 
sources en fonction du décalage indiqué.

Catalogue avec positions XY uniquement
Lorsque vous chargez une table ou un catalogue qui ne dispose pas encore de positions 
célestes mais qu’Aladin a pu détecter que deux colonnes représentent des coordonnées 
XY (en se basant sur le nom des colonnes et/ou sur les UCD qui y sont attachées), la 
fenêtre de calibration du catalogue s’ouvre immédiatement, vous invitant à créer une 
calibration pour ces sources.

Sauvegarde d’un catalogue recalibré
Lorsque  vous  sauvegardez  un  catalogue,  après  l’avoir  recalibré,  Aladin  ajoute 
systématiquement les deux colonnes de la position céleste de chaque source.

5.9 Générateur d’images couleurs RVB

Icône : rvb
Menu : Image => Créer une image RVB…

Aladin peut créer une image en vraies 
couleurs à partir de 2 ou 3 images en 
« niveaux de  gris ».  Pour  cela,  il 
affectera à la composante « rouge » la 
première  image,  et  pour  les  deux 
autres  composantes  « vert »  et 
« bleu »  les  deux  autres  images. 
L’image  en  vraies  couleurs  sera 
mémorisée dans un plan de la pile. 
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Astuce : Lorsque le curseur de la souris se trouve sur le logo du plan RVB créé, les logos 
des 3 images originales apparaissent dans la couleur de leur composante propre.

Rééchantillonnage

Afin que les pixels des images correspondent aux mêmes positions dans le ciel, Aladin 
effectue  un  rééchantillonnage  sur  deux  des  images  en  fonction  de  la  solution 
astrométrique de la troisième. Celle-ci est appelée « image de référence ». Par défaut, ce 
sera l’image dont la taille angulaire du pixel est la plus petite qui sera prise en référence. 
Le  rééchantillonnage  est  basé  sur  l’algorithme  du  « pixel  le  plus  proche »  (cf.   5.11 - 
rééchantillonnage)

Accès à la fenêtre

La  fenêtre  pour  générer  une  image 
couleur  est  accessible  soit  par  le  menu 
« Image  => Créer une image RVB… » soit 
par le bouton « rvb ».

Le  choix  par  défaut  des  images  pour 
chaque composante dépend de l’état de 
la  pile.  S’il  y  a  deux  ou  trois  plans 
sélectionnées,  Aladin va les utiliser pour 
renseigner  le  formulaire.  sinon,  Aladin 
considérera les  3 images  du haut  de la 
pile,  ou  à  défaut  les  2  premières.  S’il 
connaît  les  longueurs  d’ondes  des 

images, Aladin les trie en fonction de ce paramètre.

Cas particulier de 2 images

Il est possible de ne sélectionner que 2 images. Dans ce cas, la 3ème 

composante  couleur  sera  calculée  en  fonction  des  2  autres  en 
prenant  à chaque fois  la  moyenne des valeurs  des deux autres 
images.  Cette  méthode construit  de très  belles  images  colorées 
particulièrement si la composante laissée libre est le vert (mode 
par défaut).

Différences entre 2 images  
Avec  2  images,  il  est  également  possible  d’effectuer  une 
soustraction  colorée.  Les  différences  positives  seront  les 
valeurs  de  la  première  composante  couleur,  les  différences 
négatives  celles  de  la  seconde  composante  couleur.  D’autre 
part, les différences vont être normalisées entre 0 et 255 pour 
offrir  un  contraste  maximal.  Cette  méthode  est  très 
intéressante pour visualiser rapidement les variations, même 
minimes, entre 2 images.
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5.10Associations d’images : cubes & mosaïques

Icône : assoc
Menu : Image => Créer une image mosaïques…

Image => Créer une séquence animée…

Aladin peut associer 2 ou plusieurs images en les combinant soit sous la forme d’un cube 
qu’il affichera comme une séquence animée, soit en créant une nouvelle image mosaïque 
des images originales.

Accès à la fenêtre d’association

La fenêtre qui s’ouvre via le menu « Image => créer  
une  image  mosaïque »  ou  « Image  => Créer  une 
séquence animée », ou encore par le bouton « assoc » 
vous  permet  de  contrôler  l’association.  Vous  y 
indiquerez  les  plans  images  originaux,  le  délai 
initial  de  séquence  dans  le  cas  de  la  production 
d’un  cube  et  l’image  de  référence  s’il  y  a  lieu 
d’effectuer  un  rééchantillonnage  pour  superposer 
les pixels.

Mosaïque

Dans  le  cas  de  la  production  d’une  image 
« mosaïque », l’image obtenue aura la taille requise 
pour  contenir  toutes  les  images  originales  dans  la  grille  de  projection de  l’image de 
référence. L’image obtenue sera visualisée et manipulable comme tout autre image dans 
Aladin. La moyenne sera utilisée pour les zones de recouvrements.

Cube ou « séquence animée »

Un cube est visualisé par Aladin comme une séquence animée, c'est-à-dire image après 
image. Le logo dans la pile est repérable par un double trait à sa base symbolisant 
l’épaisseur du cube. La manipulation d’un cube est décrite dans la section concernant 
« la vue » en 5.1.2.
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Astuce : Il est possible d’ajouter une nouvelle image à un cube existant. Pour cela, vous 
devez cliquer/glisser le logo du plan de la nouvelle image dans la vue où le cube est en 
train de défiler. Après une courte pause nécessaire au rééchantillonnage de la nouvelle 
image, le défilement du cube reprend avec une image de plus.

5.11 Rééchantillonnage d’images
Menu : Image => Rééchantillonner…

Principe

Même si elle concerne le même champ du ciel, chaque image dispose généralement de sa 
propre  solution  astrométrique.  Cela  signifie  qu’un  pixel  particulier  ne  pointe  pas 
nécessairement au même endroit dans le ciel. Pour comparer deux images pixel à pixel, 
il est souvent nécessaire de rééchantillonner l’une d’elle en fonction de l’autre, appelée 
« image de référence ». Concrètement Aladin parcourra toutes les positions des pixels de 
l’image de référence, en déduira leurs coordonnées dans le ciel, puis en utilisant cette 
fois-ci  la  solution  astrométrique  de  la  deuxième  image,  et  ce  pour  chaque  position 
céleste précédemment calculée, il en déduira la valeur du pixel, soit le plus proche de la 
position trouvée, soit une approximation bilinéaire des 4 pixels les plus proches. A la fin 
du processus vous disposerez de deux images ayant la même « grille » de pixels pour 
une unique solution astrométrique. 

Accès à la fenêtre

La  fenêtre  qui  contrôle  le  rééchantillonnage 
s’ouvre  par  le  menu  « Image  => 
Rééchantillonner ».  Il  aura  fallu  au  préalable 
sélectionner  dans  la  pile  l’image  à 
rééchantillonner.  Dans la fenêtre,  vous devez 
indiquer l’image de référence, s’il faut ou non 
garder la valeur des « full » pixels, ou juste les 
« niveaux de gris » codés sur 8 bits (méthode 
plus rapide),  choisir  la  méthode d’estimation 
de  la  valeur  des  pixels  et  enfin  indiquer  si 
l’image  originale  doit  être  remplacée  par 

l’image rééchantillonnée ou conservée dans la pile.

Attention : Il faut noter que les méthodes de rééchantillonnage proposées par Aladin ne 
conservent  pas  le  flux,  c’est-à-dire  que  la  somme  des  valeurs  des  pixels  avant 
rééchantillonnage n’est pas la même qu’après.
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A  noter  : Une  image  ayant  été  rééchantillonnée  fait  apparaître  dans  la  vue  le  logo 

suivant : 

Astuce : L’utilisation de la semi transparence des images (cf. 5.1) fournit une alternative 
bien plus rapide et souple par rapport au rééchantillonnage. Elle est cependant moins 
précise puisqu’elle n’agit  pas pixel par pixel mais uniquement en se basant sur les 4 
coins et en approximant globalement la position des autres pixels.

5.12Opérations arithmétiques sur les images
Menu : Image => Opérations arithmétiques…

Image => Convolutions
Image => Normalisation des pixels

Addition,  soustraction,  multiplication  et 
division

Aladin offre une interface simple pour effectuer les 
calculs  de base sur un couple d’images :  addition, 
soustraction, multiplication, division. La fenêtre de 
contrôle s’ouvre via le menu « Image => Opérations  
arithmétiques » (accessible uniquement si au moins 
deux  images  sont  présentes  dans  la  pile).  Aladin 

procédera  pixel  par  pixel  en  effectuant  le  cas  échéant  une  rééchantillonnage  de  la 
deuxième image pour qu’elle corresponde à la grille de pixels de la première (cf. 5.11). Il 
est possible de demander une normalisation préalable des pixels de deux images afin 
que leurs valeurs soient réparties autour de 1 par division préalable par la moyenne. Le 
résultat de l’opération sera vu comme un nouveau plan image dans la pile.

Astuce : Si vous désirez utiliser un scalaire en deuxième opérande plutôt qu’une autre 
image - par exemple ajouter une certaine valeur à tous les pixels -  vous devez utiliser les 
commandes scripts : +, -, *, /(cf. 7.1)

Convolution

D’autre  part,  le  menu  « Image  => Convolutions … »  permet  de  « convoluer »  l’image 
courante  avec  une  matrice  spécifique,  c’est-à-dire  calculer  une  nouvelle  image  en 
fonction du produit de chaque pixel d’origine (et ceux à proximité) avec une matrice 
particulière.  Le sous menu propose les matrices couramment utilisées en astronomie 
(Gauss,  Mex,  Tophat,  …)  de  différentes  tailles.  Vous  pouvez  également  définir  votre 
propre  matrice  de  convolution  en  utilisant  la  commande  script :  « conv »  (cf.  7.1). 
L’image résultante remplacera l’image d’origine dans la pile. Si vous désirez conserver 
l’image originale il est par conséquent nécessaire de la dupliquer au préalable (menu : 
« Image => Dupliquer »)
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5.13Sauvegardes, exportations et impressions
Icône : 
Menu : Fichier => Enregistrer…, Fichier => Exporter…

Fichier => Sauvegarder…, Fichier => Imprimer…
Raccourci : Ctrl +S,  Ctrl +P

En  utilisant  l’icône  en  haut  à 
gauche  sous  la  barre  de  menu 
représentant  une  « disquette », 
vous  ouvrez  la  fenêtre  de  gestion 
des  sauvegardes  et  exportations. 
Vous pouvez également utiliser les 

diverses  possibilités  qu’offre  le  menu « fichier »  pour  effectuer  directement  l’action 
souhaitée.

Aladin dispose de plusieurs possibilités pour enregistrer votre travail :
 Impression de la vue (ou des vues) ;
 Sauvegarde  de  la  vue 
courante.  Les  formats 
supportés  sont  BMP,  JPEG, 
PNG et EPS. Le dernier format 
est  spécialement  indiqué  pour 
une publication scientifique ;
 Conservation  de  la  pile  et 
des vues pour une réutilisation 
ultérieure ;
 Exportation  d’un  ou 
plusieurs  plans  de  la  pile.  Les 
images  seront  exportées  en 
FITS ou JPEG (pour les images 
couleurs), les catalogues en TSV 
(Tab-Separated-Value)  ou 
VOTable (cf. 8.2) ;
 Accès aux URL ayant fourni 
les images et les catalogues.

Génération d’une carte « cliquable »

Dans le  cas de la sauvegarde de la  vue Aladin propose le  format « PNG+LINK ».  Ce 
format est dédié à la création de « cartes Web cliquables ». La vue est enregistrée au 
format PNG classique. Un deuxième fichier est généré simultanément ayant l’extension 
« .lnk ».  Il contient dans un format ASCII très simple les objets cliquables présents dans 
la vue, leur position dans l’image PNG ainsi qu’une URL pour accéder à l’enregistrement 
complet associé. Ces deux fichiers placés sur un serveur Web vont permettre de réaliser 
à moindre frais une carte cliquable. Pour plus de détail sur la méthode, le format et des 
exemples  d’implantation,  veuillez  consulter  l’adresse  suivante :  http://aladin.u-
strasbg.fr/java/FAQ.htx#Map
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5.14Les préférences utilisateurs
Menu : Edition => Préférences utilisateurs…

Aladin  regroupe  dans  la  fenêtre  des  préférences  la  plupart  des  paramètres  de 
configuration propres à l’utilisateur. Vous pouvez ainsi définir les éléments suivants :
 La langue de l’interface graphique (anglais, français, italien, …) ;
 Le mode de démarrage d’Aladin,  c’est-à-dire pour professionnels  (« astronomer »), 

pour  les  scolaires  (« undergraduate »)  ou  en  simple  fenêtre  de  visualisation 
dynamique (« preview ») (cf.5.1.2).

 Le répertoire par défaut où Aladin cherchera ou sauvegardera les fichiers locaux ;
 Le mode d’affichage des pixels par défaut (vidéo inversée, table des couleurs…) ; 
 En cas de chargement de table ASCII, le caractère utilisé pour séparer les colonnes 

(TAB, ‘ ;’, …) ;
 L’activation ou non des filtres dédiés (cf. 5.5 - utilisation des filtres) ;
 Le niveau  de  semi  transparence  des  champs instrumentaux  (cf.  5.2.6 -  FoV)  par 

défaut ;
 Le serveur d’image par défaut (en cas d’interrogation par simple mention d’un objet 

astronomique) ;
 Le site par défaut de l’annuaire des serveurs (cf.  5.2.1 – le sélecteur de serveurs) , 

c’est-à-dire  la  machine  qui  lui  fournit  à  chaque démarrage  la  liste  des  serveurs 
disponibles, les paramètres à saisir… ;

 Suivant la configuration matérielle, le navigateur de votre choix pour l’affichage des 
informations Web ;

La fenêtre des préférences permet également :
 De créer sa propre langue de traduction (voir ci-dessous) ;
 De recharger en cours de session toutes les définitions des serveurs de données, ce 

qui aura également l’effet de réinitialiser le cache interne des méta données d’Aladin

Certains  paramètres  ne  sont  pas  configurables,  mais  simplement  conservés  d’une 
session à l’autre, par exemple, la taille et l’emplacement de la fenêtre Aladin, le type de 
réticule (large ou classique), l’activation ou non des infobulles sur les sources…

Astuce : Les paramètres de configurations sont conservés dans un simple fichier ASCII 
« Aladin.conf » qui  peut  être  éditer  dans le  répertoire  « .aladin »  présent  dans votre 
répertoire  d’accueil  ($HOME  en  unix,  \Document  and  Settings\YourName  en 
Windows). Pour réinitialiser les paramètres dans la configuration d’origine il suffit de 
supprimer ce fichier.

Gestion des langues de l’interface

Aladin supporte plusieurs langues pour son interface graphique. Il est possible de créer 
sa propre traduction si la langue que vous souhaitez n’est pas encore supportée. Pour 
cela utilisez le bouton « Nouvelle traduction » et spécifiez – en anglais – votre langue ainsi 
que le code « 2 lettres » qui y correspond (ex : "French" - "fr"). Aladin ouvre une fenêtre 
d’édition  qui  affiche  l’ensemble  des  expressions  qu’il  est  nécessaire  de  traduire  (en 
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anglais),  celles  qui  ont  déjà  été  traduites  le  cas  échéant  et  celles  qui  ne  sont  plus 
nécessaires (utilisées par une version antérieure  par exemple).  Vous pouvez installer 
votre traduction qui apparaîtra à la prochaine session comme une alternative possible de 
langage dans la liste des traductions supportées.

Précisions :
 Les expressions qui ne sont pas traduites apparaîtront en anglais.
 Aladin supporte les langages non ASCII (ex : chinois…) et éventuellement écrits de 

droite à gauche (ex : persan…).
 Il  est  possible de compléter ou corriger  une traduction existante.  Pour cela  il  est 

nécessaire d’installer au préalable la langue en question puis d’appuyer sur le bouton 
« Nouvelle traduction » en laissant vide les champs « Langue » et « Code 2 lettres ». 
Vos compléments de traduction ne concerneront que votre installation d’Aladin.

A noter : Si vous le désirez, vous pouvez contacter le CDS et l’équipe de développement 
d’Aladin afin de faire profiter  la  communauté  des utilisateurs  de votre travail.  Votre 
fichier  de  traduction  est  sauvegardé  dans  le  même  répertoire  que  le  fichier  de 
configuration  d’Aladin  (voir  ci-dessus)  avec  le  nom  « Aladin-langue-version-
perso.string… ».

5.15  La console de commandes
Menu : Outil => Console de commandes…
Raccourci : F5

Toutes les actions réalisables via l’interface graphique peuvent également être faites par 
des « commandes en ligne ». Le but est de pouvoir utiliser Aladin en mode « script » pour 
effectuer  des  travaux  répétitifs, 
indiquer  des  traitements  à 
effectuer  ou  contrôler  Aladin  à 
distance. 

Ces  commandes  peuvent  être 
soumises  par  différents 
canaux dont les deux principaux 
sont :
 L’entrée standard
 La « Console de commande »

La console de commande s’ouvre 
par le menu « Outil => console de 
commandes… ».  Cette  fenêtre 
visualise entre crochets toutes les 
commandes  équivalentes  aux 
actions qui ont été déjà réalisées via l’interface graphique. C’est une aide pratique pour 
apprendre  la  syntaxe.  Il  est  possible  de  taper  directement  une  commande  après  le 
prompt  « Command> ».  Les  flèches  BAS  et  HAUT  permettent  de  faire  défiler  les 
commandes déjà soumises afin de les rééditer, les modifier et les exécuter à nouveau.
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Astuce : Veillez à toujours saisir  après le  prompt  « Command> ».  Si  celui-ci  n’est  pas 
affiché, taper la touche Entrée pour faire apparaître une nouvelle ligne. 

Alternative à la console

Pour passer rapidement une commande sans ouvrir la console, il est possible de la saisir 
directement dans le champ utilisé par Aladin pour indiquer la position courante sous la 
souris dans le bandeau de localisation.

Veuillez vous référer à la  section « Aladin par script » (cf.  7.1,  ci-dessous) pour plus 
d’information sur le contrôle d’Aladin par script

6 Les outils annexes
Aladin dispose de quelques outils supplémentaires permettant de faciliter votre travail, 
dont entre autres :
 Le pointeur Simbad pour la découverte automatique des objets d’intérêt
 Un gestionnaire de « macros » pour les travaux répétitifs
 Un  mécanisme  d’interactions  avec  d’autres  outils  astronomiques  compatibles 

« Observatoire Virtuel»
 L’outil d’extraction de source : S-extractor
 Un générateur de « vues vignettes »

Nous allons présenter rapidement chacun de ces outils.

6.1 Le pointeur Simbad

Menu : Outil => Le pointeur automatique Simbad…

Pour faciliter l’exploration d’une image, l’activation du « pointeur 
Simbad »  va  entraîner  un  dialogue  continu  entre  la  base  de 
données  Simbad  et  votre  session  Aladin.  Dès  que  votre  souris 
restera  positionnée  au  même  emplacement  plus  de  quelques 
secondes,  Aladin  va  rapidement  interroger  la  base  de  données 
Simbad du CDS afin d’afficher les informations de bases de l’objet 
(identificateur  principal,  type  d’objet,  type  spectral…)  le  plus 
« intéressant »  à  proximité  de  votre  pointeur.  Le  critère  de 
sélection se base sur le nombre de références bibliographiques dont l’objet est crédité. 

A noter : Dans le cas où vous auriez déjà chargé les résultats de Simbad dans un plan 
catalogue, Aladin utilisera ces données pour éviter des interrogations supplémentaires.

6.2 Le gestionnaire de macros

Menu : Outil => Macros…
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Pour  faciliter  les  traitements 
répétitifs,  Aladin  offre  un 
mécanisme  de  « macros »  basé 
sur  les  commandes  scripts  (cf. 
7.1). Il s’agit de rédiger un script 
utilisant  des  commandes 
textuelles  et  pouvant  incorporer 
des noms de variables afin que le 
script  puisse  être  utilisé  de 
manière  répétitive,  par  exemple 
sur une liste de noms d’objets…

La fenêtre des macros s’ouvre via 
le menu « Outils  => Macros… ». 
Elle est divisée en 3 parties :
 Le panneau supérieur permet 

la  saisie  d’un  script.  Celui-ci 
pourra  inclure  des 
« variables » nommées $1, $2, 
etc.

 Le panneau du milieu permet 
de fournir la liste des valeurs 
que  peuvent  prendre  les 
variables

 Le panneau du bas permet de 
contrôler l’exécution

Le  script  ainsi  que  les  valeurs  des  paramètres  peuvent  être  sauvegardés  afin  d’être 
rechargés ultérieurement (menu propre à la fenêtre)

Astuce : Lors de la saisie du script, Aladin reconnaît automatiquement la syntaxe et la 
met  en valeur à  l’aide  de couleurs.  Les commandes sont  « cliquables » pour afficher 
rapidement de l’aide s’y rapportant.

6.3 Interaction avec les outils VO : SAMP

Menu : Outil => Outils VO…

Aladin manipule des images et des catalogues pour générer des vues. Il peut cependant 
s’appuyer sur d’autres applications indépendantes pour effectuer d’autres traitements 
tels que générer des graphes 2D, afficher des spectres… Pour cela, Aladin implante un 
mécanisme issu d’un standard de l’Observatoire Virtuel nommé SAMP (précédemment 
nommé PLASTIC).
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Principe

SAMP permet de faire dialoguer des applications pour que non seulement elles puissent 
se transmettre des données, mais également interagir.  Ainsi la sélection d’une source 
astronomique sera, par exemple, visualisée simultanément dans toutes les applications.

Installation

Aladin  facilite  l’utilisation  de  SAMP  en  présentant  dans  une  fenêtre  la  liste  des 
applications qui peuvent « être combinées » avec Aladin. Cette fenêtre offre la possibilité 
d’installer facilement l’une ou l’autre de ces applications, afin qu’elles apparaissent dans 
le menu « Outil => Outils VO =>… », et qu’elles puissent ainsi être démarrées facilement. 
Cette liste est maintenue à jour dynamiquement, elle fait ainsi apparaître les nouveautés, 
les nouvelles versions disponibles…

Connexion SAMP

Pour faire interagir  deux applications compatibles  SAMP il  suffit  qu’elles  s’exécutent 
simultanément.  Aladin  offre  la  possibilité  de  démarrer  une  autre  application  SAMP 
directement à partir du menu « Outil => Outils VO…». 

Lorsque les deux applications s’exécutent, elles se « verront »  l’une l’autre  suivant le 
mode  qui  est  propre  à  chacune,  par  exemple  dans  un  menu  « Interop »  (TOPCAT, 
VOPlot,  VOSpec,  Aladin…),  « File  =>  SAMP »  (DS9),  ou  au  moyen  d’une  icône 
particulière (Virgo, Aladin).
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Aladin visualise les « connexions » SAMP au moyen de l’icône représentant une antenne 
radar en bas à droite  de sa fenêtre principale.  Si  celle-ci  est dessinée avec une série 
« d’ondes », cela signifie qu’une ou plusieurs autres applications compatibles SAMP sont 
en cours d’exécution et peuvent interagir avec Aladin. 

 
Le menu « Interop » regroupe l'ensemble des fonctionnalités associées à SAMP et permet 
d'accéder aux options. Il est également possible d'utiliser le menu contextuel (clic-droit 
ou CTRL clic) en plaçant la souris directement sur « l'antenne ».

Transfert de données

Une  fois  Aladin  « connecté »  à  une  autre  application,  il  peut  recevoir  des  données 
(images, tables…) qui apparaîtront sous la forme de nouveaux plans dans la pile. Il peut 
également  envoyer  des  données.  La  méthode consiste  à  sélectionner  le  ou les  plans 
concernés dans la pile, puis à ouvrir le menu « Interop » afin de désigner l’application 
SAMP « cible » dans le sous-menu adéquat.

Interactions

Généralement,  lorsque  les  données  sont  des  tables  ou  des  catalogues,  les  sources 
sélectionnées  dans  une  des  applications  sont  automatiquement  sélectionnées  dans 
l’autre application. C’est une méthode très pratique pour, par exemple, repérer où se 
situe dans le champ Aladin les sources présentant des particularités dans leurs mesures 
dans un graphe couleur/couleur dans VOPlot.
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A  noter  : Les  actions  «SAMP»  dépendent  des  applications,  il  est  possible  qu’une 
sélection d’objet soit simplement ignorée par une application compatible SAMP mais qui 
n’a pas voulu implanter cette possibilité.

6.4 Extraction de sources via SExtractor

Menu : Outil => Outils distants => S-extractor…

Aladin ne dispose pas nativement d’outils photométrique. Cependant, il peut faire appel 
à « SExtractor » qui est un logiciel couramment utilisé par les astronomes pour extraire 
des sources d’une image et calculer des valeurs de magnitude (Bertin & Arnouts – 1996). 

Le menu « Outil  => Outils distants => S-extractor » ouvre le « Sélecteur de serveur » sur 
l’onglet concernant l’outil SExtrator. Ce formulaire présente les paramètres principaux 
pour l’extraction de source et un sélecteur pour désigner le plan – image concerné.
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La validation de ce formulaire  entraîne  l’interrogation à  distance  d’une « ferme » de 
machines implantées au CDS à Strasbourg et dédiée à ce type de travaux. Ces machines 
vont exécuter SExtractor sur votre image,  et  retourner la table des sources extraites. 
Celles-ci apparaîtront dans la pile et donc projetées sur l’image.

A noter : Dans le cas où l’image est locale (sur votre disque dur), il sera éventuellement 
nécessaire d’autoriser SExtractor - s’exécutant à Strasbourg -  à accéder temporairement 
à un port réseau particulier  de votre machine afin qu’Aladin lui fournisse l’image de 
travail. La présence de pare-feu sur votre machine, voire sur votre fournisseur d’accès 
Internet peut rendre la manipulation difficile, voire impossible. En revanche, les images 
issues d’un serveur externe pourront être utilisées sans souci de ce type.

6.5 Génération de vues « vignettes »

Menu : Vue => Créer des vues vignettes…

Aladin offre la possibilité de créer facilement des « vignettes » pour une liste d’objets, 
c’est-à-dire une séries de d’images centrées sur les objets de la liste. Pour cela, Aladin 
propose de créer autant de « vues »  (cf. 5.1.2)  que d’objets. Les objets en question sont 
soit ceux qui sont sélectionnées dans la vue courante, soit toutes les sources d’un plan 
catalogue ou d’un plan ne contenant que des marques graphiques.

Exemple d’utilisation

Supposons que nous voulions créer des vignettes 
de  tous  les  objets  susceptibles  d’être  des 
« nébuleuses planétaires » pour le champ centré 
sur « Coma cluster » :
 Chargeons une image DSS, ainsi que Simbad
 Sélectionnons  les  sources  recherchées  en 

spécifiant  « PN ? »   dans  le  champ  de 
recherche en bas à droite + Go

 Créons les vues  vignettes via le menu « Vue 
=> Créer des vues vignettes »

Les  vues  « vignettes »  sont  automatiquement 
« verrouillées » sur leur position centrale comme le signale le petit cadenas en bas à 
gauche de chacune d’elles (cf. 5.1.2 – vue verrouillée).

Astuce : Puisque les vues vignettes sont toutes verrouillées il est facile de ne supprimer 
qu’elles en utilisant le menu « Vue => Supprimer toutes les vues verrouillées ».

Astuce : Il est pratique de « scotcher » la vue initiale globales afin d’éviter de la faire 
défiler avec les autres lors de la manipulation de la barre de défilement verticale.
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Vignettes issues de plusieurs images

Il est également possible de sélectionner plusieurs 
images sources pour comparer par exemple deux à 
deux  des  vignettes  issues  de  deux  images 
différentes. Pour cela il suffit de sélectionner dans 
la  pile  les  plans  images  concernés  en  plus  des 
sources. Chaque source donnera lieu à la création 
de 2 vignettes. Un affichage en multivue 2x1 ou 2x2 
ou 4x4 facilitera la comparaison.

7 Aladin pour les experts
Dans  cette  section  nous  allons  brièvement  présenter  différents  aspects  d’Aladin 
s’adressant à des utilisateurs avertis ou à des fournisseurs de données qui voudraient 
faire bénéficier leurs utilisateurs des potentialités d’Aladin. Nous verrons ainsi :
 Comment utiliser Aladin en mode script ;
 Comment utiliser Aladin en tant qu’applet ;
 Etendre ses possibilités en développant des plugins java ;
 Comment dialoguer entre IDL et Aladin

7.1 Aladin par script
En  alternative  à  l’interface  graphique,  Aladin  peut  être  piloté  par  des  commandes 
textuelles. Celles-ci permettent d’effectuer les mêmes opérations que via la souris mais 
dans un environnement où « l’interlocuteur » n’est  pas nécessairement un utilisateur 
devant son clavier mais peut être un autre programme. 

Les différentes applications des commandes scripts

Les commandes scripts peuvent être utilisées dans différents contextes : 
 En alternative à la souris via la console ou le champ de position (cf. ci-dessus)
 Comme contrôle « à distance » par un autre programme via :

 l’entrée standard. Un shell script, ou autre script PERL pourra ainsi soumettre 
des commandes à Aladin

 la  méthode  « execCommand(String) »  pour  qu’une  autre  application  java 
partageant  la  même  machine  virtuelle  Java  (JVM)  puisse  « dialoguer »  avec 
Aladin.  (http://aladin.u-strasbg.fr/java/FAQ.htx#Launch)

 la méthode  « execAsyncCommand(String) » pour contrôler Aladin en mode applet 
depuis des fonctions JavaScript (cf. ci-dessous)

 Comme initialisation de l’applet Aladin (cf. section suivante)
 Pour rédiger des « macros » (cf. section précédente)
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Exemple de script  

Exemple :  Chargement d’une image par URL, ajout de Simbad, activation 
de la grille et passage en table des couleurs « BB » :

get File(http://monServeur/monImage.fits)
sync
get Simbad
grid on
cm bb noreverse

Liste des commandes

Pour connaître la liste des commandes et obtenir de l’aide sur chacune d’elle,  Aladin 
intègre une aide en ligne accessible par le menu « Aide => Aide sur les commandes en ligne  
d’Aladin ».   Celle-ci  transforme temporairement  le  panneau  de  la  vue  en  hypertexte 
permettant de naviguer rapidement dans cette aide.

Utilisation des plans de la pile comme des « variables »

Dans le  contexte des scripts,  il  est  possible d’utiliser  les plans de la pile comme des 
« variables » accessibles par leur nom ou par leur position dans la pile. Ainsi toutes les 
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commandes  scripts  générant  un  plan  peuvent  être  préfixées  par  « NomPlan = 
commande… »  pour indiquer que le  résultat  de la  commande va être  affecté  au plan 
« NomPlan » (resp.  @nnn où nnn est le numéro du plan - @1 étant le plan du bas de la 
pile). Si celui-ci existe déjà, la précédente « valeur » de ce plan sera remplacée, sinon il 
sera créé sur le haut de la pile. 

Exemple :  Affectation au plan « MonImage » d’une image
DSS/ESO de M1:

MonImage = get ESO(DSS1) M1

Cette méthode s’avère particulièrement pratique et puissante lorsque les commandes 
scripts concernent les opérations arithmétiques sur les images (additions, soustraction, 
multiplication, soustraction, normalisation, convolution…)

Exemple :  Différence de 2 images en couleur J et F :
A = get Aladin(J) M1
B = get Aladin(F) M1
Diff = A – B

7.2 Vos données visibles par Aladin en applet
Comme  indiqué  au  début  de  ce  manuel  (cf.  2),  Aladin  peut  être  exécuté  en  tant 
qu’extension d’un navigateur Web (IExplorer, Firefox, Mozilla …)  sous la forme d’une 
applet java. Cette méthode offre la possibilité à des fournisseurs de données (images, 
catalogues) de proposer à leurs utilisateurs l’usage d’Aladin pour visualiser leurs propres 
données sans les contraindre à installer un outil particulier.  

Démarrer Aladin en applet

Le démarrage d’Aladin en applet revient simplement à appeler une URL sur le Web. Il 
existe plusieurs sites qui fournissent l’applet Aladin (cf. 2 - Aladin en applet)

Astuce : Par  défaut,  Aladin  s’affiche  à  l’intérieur  de  la  page  Web.  Il  est  cependant 
possible de lancer l’applet Aladin dans sa propre fenêtre en ou même en simple mode 
« preview » (cf.  5.1.2 –  simple  fenêtre).  Consultez  la  FAQ  à  l’adresse  suivante : 
http://aladin.u-strasbg.fr/java/FAQ.htx#startapplet

Contrôler Aladin en applet

Afin de fournir à l’applet Aladin des données particulières à afficher, il est nécessaire de 
lui passer des commandes scripts. Ces commandes permettront notamment d’indiquer à 
Aladin comment charger une image, un catalogue particulier....  Il existe deux moyens 
pour transmettre à Aladin ces commandes : le paramètre « -script » de l’URL d’appel de 
l’applet, ou une méthode dédiée à Java Script.
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Le paramètre «     -script     »  
L’URL d’appel de l’applet accepte un paramètre « -script=xxx » où « xxx » est un script 
Aladin, c'est-à-dire plusieurs commandes séparées par des ‘ ;’.  Ce script sera exécuté 
juste après l’initialisation d’Aladin, ce qui permettra de charger des données à visualiser.

Exemple :  Démarrage de l’applet avec chargement de données
+ affichage de la grille

http://.../nph-aladin.pl?-script=get+File(http://xxx);grid+on

Astuce : Le site Web d’Aladin fournit un formulaire pour vous aider à générer la bonne 
URL d’appel en fonction de vos besoins. N’hésitez pas à vous y référer : http://aladin.u-
strasbg.fr/java/nph-aladin.pl?frame=form

En JavaScript  
Aladin  en mode  applet  peut  être  également  contrôlé  via  une  fonction  JavaScript  en 
utilisant la référence suivante : 

document.aladin.execAsyncCommand(script)

Contrairement  à  la  méthode  précédente  via  le  paramètre  « -script »,  l’utilisation  de 
JavaScript va permettre de modifier le comportement de l’applet Aladin en cours de 
session. Il ne sera pas nécessaire de « redémarrer » (ré-instancier) Aladin pour chaque 
nouvelle donnée à visualiser.

Pour plus d’informations sur le contrôle par JavaScript,  veuillez vous référer au FAQ 
(http://aladin.u-strasbg.fr/java/FAQ.htx#JavaScript).  Et  de  manière  général,  pour 
afficher  vos  propres  données,  n’hésitez  pas  à  consulter  la  page  Web  suivante : 
http://aladin.u-strasbg.fr/java/HowToProvideMyData.htx

7.3 Extension d’Aladin : les « plugins »
Menu : Outil => Plugins…

Aladin a été écrit dans le langage de programmation Java. Il est possible d’écrire des 
extensions d’Aladin  afin d’effectuer des traitements supplémentaires non prévus dans la 
version de base.  Ces extensions sont appelées  « plugins » et doivent elles-mêmes être 
écrites en Java.

Installation de plugins

L’installation et la gestion des plugins se fait depuis le « gestionnaire de plugins » via le 
menu « Outil => Plugins => Gestionnaire de plugins… ». Cette fenêtre permet de visualiser 
d’un coup d’œil  les  plugins  déjà  installés,  et  d’accéder  via  le  bouton  « Charger… »  à 
d’autres plugins disponibles sur le site officiel d’Aladin. 
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Les plugins doivent être installés,  sous forme compilée (.class ou .jar), dans le répertoire 
« .aladin/Plugins »  présent  dans  votre  répertoire  d’accueil  ($HOME sous  Unix, 
\document and Settings\yourName sous Windows).  Après les avoir copiés à cet 
emplacement, il est nécessaire de cliquer sur le bouton « Re-charge » pour qu’ils soient 
pris  en  compte.  Il  est  également  possible  de  les  glisser/déposer  depuis  votre 
environnement de travail vers la liste du « gestionnaire de plugins ».

Ecriture d’un plugin

L’écriture d’un Plugin nécessite une connaissance raisonnable du langage Java. Il s’agit 
« d’étendre »  la  classe  d’objet  « AladinPlugin »  afin  d’accéder  à  des  méthodes  de 
manipulations de la pile, des images, et des catalogues. 

La documentation technique pour réaliser un plugin est disponible à l’adresse suivante : 
http://aladin.u-strasbg.fr/java/FAQ.htx#plugins. Le moyen le plus sûr pour débuter et 
de s’inspirer d’exemples fournis sur le site officiel d’Aladin.

7.4 Interactions IDL / Aladin
IDL (Interactive  Data  Language)  est  à  la  fois  un langage  et  un moteur de  calcul  de 
traitement d’images. Il est largement utilisé dans la communauté astronomique. Vous 
trouverez  à  l’adresse  suivante :  http://aladin.u-
strasbg.fr/java/idl_aladin_interface.tar.gz un  ensemble  de  fonctions  IDL  (fichier 
d’extension « .pro ») permettant d’accéder à Aladin depuis l’environnement IDL. Il vous 
sera dès lors possible d’échanger des images, des tables, des tables de couleurs, etc.

Pour plus d’informations sur l’usage de la librairie Aladin pour IDL, veuillez vous référer 
au FAQ à l’adresses suivante : http://aladin.u-strasbg.fr/java/FAQ.htx#IDL.
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8 Bon à savoir
Aladin est un logiciel de plus de 10 ans d’âge… c’est déjà un bon crû. Vous trouverez de 
nombreuses informations techniques et  pratiques dans la FAQ disponible à l’adresse 
suivante :  http://aladin.u-strasbg.fr/java/FAQ.htx.  Ce  document  est  continuellement 
remis à jour en fonction des nouvelles versions, n’hésitez pas à y jeter de temps en temps 
un coup d’œil pour repérer les nouveautés. Il existe également quelques « tutoriaux en 
ligne », c’est-à-dire des travaux pratiques qui permettent d’expérimenter Aladin sur des 
cas d’études astronomiques. Ces tutoriaux peuvent constituer d’excellents supports pour 
des travaux étudiants (http://aladin.u-strasbg.fr/tutorials/aladin.gml).

Les sections qui suivent présentent quelques notes techniques qui peuvent éclairer la 
pratique d’Aladin. Pour plus d’informations, référez-vous à la FAQ citée ci-dessus.

8.1 Les « profils » utilisateurs
Aladin est un logiciel qui permet un grand nombre de manipulations sur les images et 
sur les catalogues. Afin de permettre une prise en main plus facile pour les utilisateurs 
débutants,  il  peut être démarré en profil  « undergraduate ».  Dans ce mode, seules les 
fonctions de base sont accessibles dans les menus et dans la barre des outils.  D’autre 
part,  Aladin peut  être  également  utilisé  pour  de  simple  « visualisation »  d’images  et 
catalogues  sans  proposer  à  l’utilisateur  l’ensemble  des  possibilités  de  l’interface 
graphique.  Pour  cela  Aladin  peut  être  démarré  en profil  « preview ».  Dans  ce  mode, 
Aladin n’affiche que la vue courante, sans les autres panneaux de la fenêtre principale.

Le profil de démarrage se configure via la fenêtre des « préférences utilisateurs » (cf. 5.14). 

Pour démarrer selon le profil  « undergraduate » il est également possible de spécifier le 
paramètre  « -outreach » sur la ligne de commande d’Aladin. Dans ce cas, l’étudiant n’a 
pas la possibilité de changer de profil en cours de session.

De  même  l’utilisation  du  paramètre  « -preview » démarrera  Aladin  selon  le  profil 
« preview » c'est-à-dire « simple fenêtre » (cf.  5.1.2 – plein écran et simple fenêtre). La 
touche ESC permet de faire réapparaître les éléments manquants de l’interface.

8.2 Les types de données supportés
Aladin  supporte  la  plupart  des  formats  utilisés  en  astronomie  que  ce  soit  pour  les 
images, pour les catalogues ou pour les « groupements » de données. D’autre part,  il 
prend en compte les algorithmes de compression les plus répandus.

Format Type de données
Visu

Aladin
Commentaires

FITS Image [+ WCS] Pas de limite de taille
JPEG Image couleur [+WCS] < 100 Megapixels1
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GIF Image couleur
PNG Image couleur

HCOMP
Compression image 
FITS

Applicable sur les images FITS 
uniquement

FITS- RGB Image [+WCS]
FITS-CUBE Cube d’images [+WCS] <1024x512x512

FITS-RICE
Compression image 
FITS

Applicable sur les images FITS 
uniquement

ASTRORES Catalogue
Prédécesseur de VOTable, 
(supporté pour compatibilité)

VOTABLE Catalogue
Standard IVOA totalement 
supporté (base64,FITS…)
<1 million de sources

FITS-ST Catalogue
Table FITS en ASCII
<1 million de sources

FITS-SB Catalogue
Table FITS en binaire
<1 million de sources

CSV & TSV Catalogue
“Character separated value”
<1 million de sources

BSV Catalogue
“Blank separated value”
<1 million de sources

SEXTRACTOR Catalogue
Format par défaut de  S-
extractor 

MFITS Données multiples FITS multiples extensions

AJ Pile Aladin Sauvegarde de la pile

AJS Script Aladin Fichier de commandes scripts

FOV Champ de vue
Description de champs de vue 
instrumental (note IVOA)

IDHA Liste d’images
Concurrent de SIA, (supporté 
pour compatibilité)

SIA Liste d’images [+WCS]
Standard IVOA
(< 10 000 lignes)

SSA Liste de spectres
Standard IVOA
(< 10 000 lignes)

GZIP Compression
Applicable sur tous les autres 
formats

Aladin reconnaît automatiquement la nature des données en se basant sur le contenu : 
l’extension du nom de fichier ou la présence d’un « Content-type » pour un flux  http 
n’ont pas d’incidence sur la reconnaissance du fichier.

Exception :  Le format  AJS (script Aladin) est une exception car sa nature ne peut être 
reconnu de façon automatique sans risque de confusion. Pour lever l’ambiguïté, Aladin 
se basera sur l’extension de fichier « .ajs » et/ou sur la présence en première ligne du 
commentaire suivant : « #AJS ».

1 Sur la base d’une machine disposant d’1Gigaoctets de RAM
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8.3 Standard FITS et calibration astrométrique
Pour la calibration astrométrique, Aladin suit le standard FITS officiel : le premier pixel 
en bas à gauche est numéroté (1,1) et la position céleste correspondante est centrée sur le 
pixel. Concrètement, la coordonnée en bas à gauche du premier pixel est donc (0.5,0.5).

A noter : IDL ne suit pas le standard FITS officiel, la coordonnée en bas à gauche du 
premier pixel est (0,0).

Aladin reconnaît plusieurs méthodes de calibrations : WCS standard, ancienne méthode 
DSS1, … ainsi que la plupart des projections courantes.

8.4 Performances et contraintes techniques
Le développement d’Aladin a suivi deux règles :

1. Garantir  la  meilleure  compatibilité  possible  avec  le  matériel  et  les  systèmes 
d’exploitation existants,

2. Offrir les meilleures performances possibles dans ce contexte

Pour  répondre  à  ces  deux  contraintes,  Aladin  tire  le  meilleur  parti  du  langage  de 
programmation  « Java ».   Les  applications  « java »  nécessitent  la  présence  d’un 
« moteur java » installé sur votre ordinateur. La plupart des systèmes d’exploitation ont 
déjà un moteur java installé par défaut. Si ce n’est pas le cas, il est possible de l’installer 
gratuitement depuis le site http://www.java.com/download. 

Un compteur situé en bas à droite de la fenêtre indique la quantité de mémoire utilisée 
par Aladin.  En maintenant la souris sur ce compteur,  une mini fenêtre détaille  cette 
valeur et indique le montant mémoire maximum exploitable. Cette limite dépend de la 
manière dont la machine java a été initialisée lors du démarrage d’Aladin. Pour accroître 
cette  valeur  veuillez  vous  référer  à  la  section  correspondante  dans  le  FAQ 
(http://aladin.u-strasbg.fr/java/FAQ.htx#huge).

8.4.1 Gestion des images

Aladin sait gérer n’importe quelle taille d’images. Suivant votre configuration matérielle 
et  la  mémoire  allouée  à  la  machine  virtuelle  Java,  Aladin  pourra  choisir  différentes 
stratégies plus ou moins rapides :
 Pour  les  images  de  quelques  mégaoctets,  l’image  est  chargée  totalement  en 

mémoire ;
 Pour les images de quelques centaines de mégaoctets, Aladin va utiliser un espace 

disque pour économiser la mémoire vive. L’impact sur la fluidité de manipulation est 
très peu sensible ;

 Pour les images de plusieurs gigaoctets, Aladin mettra en œuvre un accès en deux 
temps : un premier affichage immédiat en basse résolution, puis lorsque le facteur de 
zoom est compatible avec votre capacité mémoire, un deuxième affichage en haute 
résolution pour  la  portion de  l’image  visible.  La méthode pour  lire  l’image basse 
résolution a été optimisée pour limiter les accès disques ce qui permet d’obtenir une 
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première vue en quelques dizaines de secondes quelque soit la taille de l’image. Cette 
stratégie en deux niveaux de résolution est plus contraignante (temps d’attente du 
chargement des pixels  hautes  résolutions lors  des déplacements)  mais  permet  de 
manipuler n’importe quelle taille d’image tant qu’elle peut être stockée sur un disque 
dur.

8.4.2 Gestion des catalogues

La manipulation des catalogues se fait par un chargement complet en mémoire vive. Il 
faut compter approximativement 300 octets par sources ce qui donne une limite autour 
de 1.5 million d’objets  manipulables  avec un ordinateur  disposant  de 1  Gigaoctet  de 
RAM. En pratique la limite se situe plutôt autour de 1 million d’objets afin de laisser de 
la mémoire vive pour les images et pour les applications.
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Raccourcis clavier
Manipulation de la vue

Zoom avant F8 ou molette souris
Zoom arrière F7 ou molette souris
Glisser/déplacer la vue Alt+Z
Image suivante Tab
1 vue F1
2 vues Maj+F2
4 vues F2
9 vues F3
16 vues F4
Génération 1 vue par image F9
Uniformiser l’échelle Alt+S
Unif. l’échelle et l’orientation Alt+Q
Plein écran F11
Visualisation simple fenêtre F12

Outils
Imprimer Ctrl+P
Activation de la loupe Ctrl+G
Activation de la grille Alt+G
Activation info sur image Alt+O
Activation flèche sur cible Alt+T
Mesure de distances Alt+D

Manipulation des plans
Propriétés Alt+Entrée
Affichage en-tête FITS Alt+H

Manipulations des sources
Sélection de toutes les sources Ctrl+A
Désélection Ctrl+U
Chercher par expressions Ctrl+F

Fenêtres
Ouvrir un fichier local Ctrl+O
Charger une image Aladin Ctrl+I
Ouvrir le contrôle des pixels Ctrl+M
Fenêtre de sauvegarde Ctrl+S
Fenêtre de l’historique Ctrl+H
Console des commandes F5
Fermeture Echap

Autres
Supprimer la sélection Suppr
Tout supprimer Maj+Suprr
Aide des commandes scripts Ctrl+F5
Quitter Ctrl+W
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NGC 1313, NGC 1808, NGC 2203, NGC 2359,
NGC 2442, NGC 4438, NGC 6070, NGC 253,

Orion nebulea, RCW 38, Hercules cluster, M1,
M16, M65, M83, M96.

Compositions 2 couleurs
(DSS2 J/F ou R/I)

réalisées par Aladin.

Aladin - Manuel de l’utilisateur
Version du 30 juin 2009
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